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Розділ 3 ПОРІВНЯННЯ ПРОГРАМ КОМП'ЮТЕРНОГО 

МОДЕЛЮВАННЯ СИСТЕМ ОСВІТЛЕННЯ СПОРТИВНИХ 

СПОРУД 

 

3.1   Світлотехнічний розрахунок освітлювальних установок 

спортивних споруд. Програми світлотехнічного розрахунку.  

Алгоритм роботи в програмах 
 

Сучасні світлотехнічні розрахунки вже неможливо представити без 

використання спеціалізованого програмного забезпечення, хоча ще кілька 

років тому інженерам-світлотехнікам доводилося вести довгу і клопітку 

роботу з оптимізації освітлення навіть невеликих об'єктів, використовуючи 

при цьому масу довідкової літератури, різні графіки, таблиці, діаграми і т.д. 

Будь-яка заміна потужності або переміщення світлового приладу 

призводили до необхідності перерахунку практично всього проекту. 

Складні геометричні і технічні обчислення посилювали вплив «людського 

чинника», зростала вірогідність помилки. 

 

 
 

Рис. 3.1 
 

З широким розповсюдженням обчислювальної техніки з'явилася 

можливість спростити процедуру світлотехнічних розрахунків. Декілька 

іноземних компаній, які займаються розробкою програмного забезпечення, 

випустили свої версії програм проектування систем освітлення. Звичайно, 

основна робота з розрахунку освітлення все одно покладається на людину, 

але багато початкових даних (табличні коефіцієнти, криві сили світла 

приладів, розрахункові формули, технічні параметри джерел світла і т.п.) 

вже закладено в програмі. 
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Задача розрахунку освітлення зводиться до визначення необхідної 

кількості світлових приладів для створення нормованого значення 

освітленості на спортивних об'єктах. При цьому розроблений проект 

освітлення повинен забезпечувати мінімальні витрати на споруду і 

експлуатацію освітлювальної установки, а також відповідати нормативним 

документам тієї країни, для якої проектується система освітлення. 

При проектуванні доцільна послідовність дій, що наводиться нижче: 

1. Визначення параметрів об'єкта, що підлягає освітленню. 

2. Вибір системи освітлення. 

3. Установка нормованого значення освітленості. 

4. Вибір методу розрахунку освітленості. 

При світлотехнічному  проектуванні в основному застосовують два 

методи розрахунків – метод коефіцієнта використання і точковий метод. 

Метод коефіцієнта використання призначений для розрахунку 

середньої освітленості підлоги (стін) усередині приміщення з урахуванням 

багаторазового відбиття світла (для системи загального рівномірного 

освітлення або розрахунку необхідного числа світильників в 

освітлювальній установці за заданою величиною освітленості). Цей метод 

застосовують для розрахунку загального рівномірного освітлення при 

проектуванні освітлювальних установок для офісних, службових та інших 

робочих приміщень з відносно невеликою висотою і площею. На практиці 

значення розрахункових коефіцієнтів беруть з таблиць, що позв'язують 

геометричні розміри приміщення, відбиваючі властивості його поверхонь і 

криві сили світла використаних світильників. 

Точковий метод призначений для розрахунку освітленості в кожній 

точці заданої площини і враховує вплив на неї світлового потоку від 

кожного із світильників, розташованих в довільному порядку. В 

комп'ютерних програмах цим методом розраховують як пряму, так і 

відбиту складові освітленості. Цей метод використовується, коли 

необхідно одержати багатоваріантні розрахунки освітленості і сумістити їх 

з оцінкою інших світлотехнічних і економічних параметрів освітлювальної 

установки. Складність точкового методу полягала у відсутності 

можливості представлення кривих сил світла приладів аналітичними 

виразами і, отже, вживанні при розрахунках великої кількості таблиць, 

графіків і допоміжних матеріалів. В даний час комп'ютерна техніка 

дозволяє всюди застосовувати даний метод в практиці світлотехнічних 

розрахунків. 
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Найбільш відомі декілька світлотехнічних розрахункових 

програм:  DIALux, Relux Professional, Lightscape, Calculux і EUROPIC. 

Найпопулярніша програма DIALux створена за участю багатьох 

європейських світлотехнічних фірм (в числі яких OSRAM, Philips, THORN, 

Trilux і ін.). Кожна з фірм — творців DIALux представляє програму з 

даними власного устаткування, проте програма дозволяє створювати і нову 

базу даних світильників, що найчастіше використовуються. Формат даних, 

що вводяться, — CIBSE/TM14, IES, LDT. Все це спрощує роботу з 

програмою і економить час. Світильники можуть бути об'єднані в групи, 

проте в цьому випадку стає неможливо працювати з окремо взятим 

світильником. В останній версії DIALux 4.9 представлена широка база 

текстур, компонентів приміщень і меблів, можливість розширення якої 

також передбачена. 

У програмі DIALux результати розрахунків можна подати в будь-

якій зручній формі — як у вигляді плоских двомірних видів, так і в 

тривимірній проекції. Метод візуалізації RayTracing, що використовується 

в програмі, робить 3D-модель наочною. Проте розрахунок освітленості у 

вертикальній площині дещо ускладнює застосування програми для 

спортивних споруд. До того ж DIALux «з'їдає» досить багато ресурсів 

комп'ютера, в разі створення проекту для спортивної арени з великою 

кількістю прожекторів розрахунок займає тривалий час. 

Проте зручний інтерфейс, гнучкі настройки виведення результатів на 

друкування і можливість введення даних (світильників, меблів і текстур) 

роблять цю програму найзручнішою для розрахунку освітленості 

інтер'єрів. 

Програма Relux Professional від компанії Relux Informatik AG – 

могутній інструмент розрахунку освітленості при роботі з тривимірними 

об'єктами. Вона містить велику базу даних, що включає фотометричні дані 

світильників сорока дев'яти виробників. Програма надає можливість 

широкого вибору зображень і текстур, що дозволяє представити 

зображення об'єкту в максимально реалістичному вигляді. 

У звіті виводяться на друк всі необхідні результати розрахунків і 

тривимірне зображення приміщення (в OpenGL). Передбачені засоби для 

збереження в базі даних будь-якого бажаного виду об'єкта освітлення 

разом з розрахунковими даними. 

У додатку до основної програми можуть використовуватися модулі 

Relux Vision і ReluxCAD. Relux Vision надає розширені можливості 
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візуалізації (RayTracer), а також можливість розраховувати комбіноване 

освітлення у приміщенні. 

  
 

Рис. 3.2 
 

ReluxCAD — програма, що дозволяє організувати роботу спільно з 

програмою AutoCAD. Створені в AutoCAD креслення приміщень і 

майданчиків напряму вводяться в Relux Professional, а результати 

світлотехнічних розрахунків для конкретної споруди, одержані в 

ReluxCAD, можна передати в AutoCAD. Relux дозволяє розраховувати 

коефіцієнт дискомфорту UGR як для приміщення, так і для конкретної 

точки спостереження. Крім того, можна вивести таблицю UGR від кожного 

світильника. 

Істотним недоліком даної програми є відсутність зручних засобів 

роботи з фотометричними даними. Для кожного проекту необхідно 

створювати базу даних застосованих світильників, що ускладнює і 

уповільнює роботу з Relux Professional. 

Програма Calculux фірми Philips існує в трьох модифікаціях (для 

розрахунку відкритих майданчиків, приміщень і доріг). Хоча основним 

форматом даних Calculux є Philips Phillum, програма дозволяє вводити й 

інші фотометричні формати (CIBSE/TM14, IES, EULUMDAT і LTLI). 

Проте слід мати на увазі, що їх використання в програмі відбувається не 

завжди коректно (як, наприклад, з форматом IES). Calculux дає можливість 

розраховувати освітленість на прямокутних поверхнях в будь-якій 

площині, що визначається користувачем. У програмі можна самостійно 

задавати кількість розрахункових точок, створювати групи світильників і 

при цьому орієнтувати як окремий світильник, так і цілу їх групу. У 

програмі задана велика кількість стандартних спортивних майданчиків, що 
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дуже зручно при розрахунку як закритих, так і відкритих споруд. Є 

можливість вибору мови, на якій буде надрукований звіт. 

До недоліків програми слід віднести відсутність якісного 

тривимірного представлення результатів, проте це частково 

компенсуються високою швидкістю розрахунку. 

Спортивні й розважальні споруди вимагають значних вкладень в 

будівництво і експлуатацію. Але інвестиції у спортивні об'єкти окупляться 

тільки в тому випадку, якщо останні будуть комфортні і для глядачів, і для 

спортсменів. Правильно спроектована і змонтована освітлювальна 

установка – одна з основних умов привабливості об'єктів видовищного 

призначення.  

Для вірного вибору тієї або іншої розрахункової програми, 

проектувальнику необхідно чітко уявляти поставлені перед ним вимоги по 

проектуванню ОУ і спробувати використати програму найбільш 

раціонально. Тому нами була розроблена методика проектування ОУ 

спортивних споруд у світлотехнічних програмах. Слід зауважити, що 

світлотехнічнихй проект, як правило, займає певне місце в проекті 

вцілому; чи то проект будівництва, проект благоустрою або реконструкції. 

В зв‘язку з цим вихідними даними для початку світлотехнічного будування 

є креслення, фотографії, плани й інша електронна/цифрова інформація, що 

дає вичерпну інформацію про освітлюваємий об‘єкт. 

Основним положенням даної методики є правильний вибір 

розрахункових програм за існуючими вихідними даними про об‘єкт. 

 

Рис. 3.3 – Схема виконання етапів світлотехнічного проекту 
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Одинарними стрілками позначений зв'язок, що дозволяє на відміну 

від інженерного методу розрахунку, за короткий час проводити генерацію 

варіантів освітлення. 

Подвійними стрілками позначений шлях, який необхідно 

дотримуватись при розрахунку критих спортивних споруд з вказівкою 

певних місць прив'язок світлового обладнання. 

Вцілому, запропонована методика моделювання освітлення 

складається із сукупності кроків, яким необхідно слідувати, щоб якісно 

виконати проект освітлення. Початком методики моделювання можно 

вважати правильний вибір світлотехнічної програми. Далі – це виконання 

вищезазначеної схеми моделювання освітлення. Заключною частиною 

методики можно вважати аналіз світлового поля для визначення якості 

спроектованої ОУ. 

Розглянемо аналіз світлового поля і загальні підходи до 

проектування ОУ за допомогою світлотехнічних програм на прикладі 

проекту системи освітлення універсального спортивного комплексу. На 

цьому прикладі продемонструємо як можна виконати розрахунок якісних 

показників освітленості в світлотехнічних програмах, які допоможуть 

правильно спроектувати ОУ. 

Перед початком комп'ютерного моделювання ОУ універсального 

спортивного залу звернімося до схеми для визначення освновних етапів 

проектування.  

Необхідні вихідні дані для проектування ОУ: 

1. Детальний план і розрізи спортивної споруди у форматах *.dxf  

або *.dwg, з позначенням головної TV-камери; 

2. Відомості про клас проведення змагань; 

3. Дані про оздоблювальні матеріали і конструкції, їх колір і 

коефіцієнти відбиття; 

4. Орієнтовні місця установки світлових приладів. 

Тепер, коли маємо необхідні дані для моделювання, нам необхідно 

звернутися до діючих нормативних документів, для визначення 

світлотехнічних вимог до проектування. Особливу увагу на цьому етапі 

слід звернути на те, що крім нормативних документів, існують 

рекомендації по освітленню різноманітних спортивних федерацій, таких 

як: ФІФА і УЄФА, федерація тенісу, баскетбола, волейбола і ін. До того ж 

приоритет вибору нормованих величин залишається за спортивними 

федераціями. 
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Наступним етапом проектування освітлювальної установки, згідно 

схеми, є трьохвимірне моделювання спортивної споруди.  

На цьому етапі з‘являється проблема вибору світлотехнічної 

програми. Для того щоб правильно зробити вибір, необхідно чітко собі 

уявляти, що: 

1. Проектування освітлення на спортивних спорудах завжди 

пов‘язано з великою кількістю світлових приладів різних типів, тому в 

програмі повинно бути добре продумане управління їх масивами; 

2. Для отримання підсумкового результату проектування потрібна 

багатоваріантність, а це, як наслідок, зміна і переорієнтування десятків 

світлових приладів за варіант; 

3. Світлотехнічна программа повинна швидко і якісно проводити 

розрахунок на робочих площинах об‘єкта; 

4. В програмі повинні бути засоби по розрахунку якісних показників 

освітленості і можливість зміни шагу розрахункової сітки. 

Тому ми рекомендуємо при проведенні світлотехнічного розрахунку 

спортивних споруд користуватися програмами DIALux, Europic, Relux або 

Cаlculux. Ці програми відповідають усім зазначеним вище вимогам і 

містять всі засоби для проведення якісного світлотехнічного розрахунку. 

Далі, виходячи з рекомендованих рівней освітленості на робочих 

поверхнях (залежно від виду спорту це може бути поверхня грального 

майданчика, що проходить на рівні 1,5 м від підлоги) і умов освітленості 

обираємо ту або іншу схему розстановки світлових приладів. У нашому 

випадку використовуємо лінійне розташування прожекторів уздовж поля. 

Обираємо приблизну потужність прожекторів і проводимо 

розрахунок горизонтальної і вертикальної освітленості на гральному 

майданчику. Рекомендуємо проводити розрахунок вертикальної 

освітленості поряд з горизонтальною навіть у тих випадках, коли вона не 

регламентується нормативними документами. Легко проілюструвати, що 

при витриманні за нормами рівня горизонтальної освітленості, можна 

отримати провали вертикальної освітленості  в різних частинах ігрового 

поля, що призведе до погіршення якості телетрансляцій. 

Після проведення попереднього розрахунку виводимо результати 

освітленостей. Аналізуючи отримані дані, робимо висновки про 

правильність вибору світлового обладнання, його орієнтації, місце 

розташування або вносимо зміни і повторюємо розрахунок. Саме ця 

частина проектування освітлювальної установки за допомогою 
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світлотехнічних програм значно відрізняється від традиційного метода 

розрахунку ОУ, де із-за великих трудовитрат, складно якісно виконати 

декілька варіантів розрахунку показників освітленості. 

Які ж якісні показники освітленості ми можемо розрахувати за 

допомогою світлотехнічних програм? 

Звісно, світлотехнічні програми дають можливість отримати 

більшість традиційних якісних показників, а саме: 

- вертикальна освітленість; 

- циліндрична освітленість; 

- сферична освітленість; 

- показник дискомфорту/UGR. 

Але світлотехнічні програми також пропонують проектувальникам й 

інші оцінки якості освітлення. Однією з таких характеристик є розподіл 

освітленості або яскравості по поверхні сцени. Розподіл подається як у 

вигляді ізолюкс, так і у вигляді кольорових градацій з прив‘язкою до 

конкретних значень освітленості або яскравості. Ці якісні характеристики 

дуже важливі для правильної оцінки розподілу освітленності на робочих 

поверхнях. Завдяки тому, що в їх побудові приймають участь сотні 

розрахункових точок, вони у повному об'ємі відображають світлову картину 

розподілу світла в сцені в результаті багаторазових відбиттів і затемнень. 

Ще однією особливістю світлотехнічних программ є те, що вони 

дозволяють розробляти нові оцінки світлового поля, під конкретну ОУ. Як 

зазначалося раніше, більшість світлотехнічних програм використовує у 

розрахунках показників освітленості метод Radiosity, згідно якого в 

результаті розрахунку отримуємо значення опроміненності, в будь-якій 

точці сцени. Таким чином, додаючи в сцену освітлення об'єкти, з якими 

виконується зорова робота, можна детально (наближено до реальності) 

отримати уявлення про якість освітлення в сцені. Більш за те, можна, 

наближено до реальності змоделювати розподіл освітленості в полі зору 

віртуального спостерігача, реакція якого на розподіл світла у сцені буде 

адекватною реальному розподілу. Нажаль, технічний рівень сьогодення не 

дозволяє проводити моделювання, розрахунок і візуалізацію зі 

стовідсотковою фотореалістичністю і на те є дуже серйозні науково-

технічні перешкоди: 

1. Не виявляється можливим моделювання сцен із детальністю 

реального світу, а це в свою чергу призводить до похибки в розрахунках  і 

візуалізації; 
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2. Не можливе урахування усіх можливих явищ і процесів, що 

мають місце у просторі (око-об'єкт); 

3. Динамічний діапазон яскравості існуючих моніторів, 

відеопанелей і інших відео пристроїв значно менші, ніж у людського ока, 

що призводить до неминучих яскравісних викривлень в зображенні; 

4. Технічно неможливо проведення моделювання об‘єктів і 

отримання їх зображення у маштабі 1:1, а це призводить до викривлення 

фізіологічного сприйняття. 

Таким чином, в результаті проведення візуалізації системи 

освітлення, отримані зображення будуть відрізнятися від зображень, 

отриманих при фотозйомці реальної освітлювальної установки або її 

спостереження. З іншого боку, такі зображення якомога краще підходять 

для представлення замовнику концепції освітлення на стадії проектування. 

Дана робота не ставить перед собою задачу описання труднощів 

візуалізації і комп‘ютерної графіки. Тому нас в більшій мірі цікавлять 

числові і кольорові представлення світлотехнічних величин у 

модельованій сцені. Застосовуючи комп‘ютерні програми можна створити 

модель універсального залу очима віртуального гравця у псевдокольорах, 

де червоним кольором позначені області з підвищеним значенням 

освітленості / яскравості, а синім кольором, навпаки області з недостатнім 

значенням цих величин. Слід зауважити, що генерація такого роду 

зображень займає декілька хвилин, а проектувальник отримує повну 

світлотехнічну інформацію про освітлювальну установку. 

Іншим варіантом отримання якісних показників освітлення може 

служити введення в сцену так званих фіктивних поверхонь. Фіктивні    

поверхні – це поверхні, що беруть участь в перерозподілі випромінювання 

в сцені, мають коефіцієнт відбиття 0%, пропускання 100% і не приймають 

участі у візуалізації, при цьому на них розраховується значення 

освітленості. Установка таких поверхонь в повздовжньому і поперековому 

розрізах сцени з певним кроком дозволить отримати чисельно або у 

псевдокольорах значення освітленості в освітлюваному просторі. У 

першому наближенні сумарний розподіл на таких поверхнях надає тіло 

освітленості адекватне тілу яскравості (при дифузних поверхнях), завдяки 

якому можна дати оцінку наповнення світлом приміщення, виконати 

прогноз тінерозподілу, виявити слабко освітлені або занадто освітлені 

області в просторі. Іншими словами, таке тіло освітленості/яскравості 
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надає проектувальнику повну інформацію про освітлювальну установку, 

що розробляється. 

Таким чином, сформований кістяк основних етапів (кроків) 

сучасного моделювання освітлення за допомогою світлотехнічних 

програм, в якому самі програми виступають лише розрахунковими 

інструментами. 

 
 

3.2 Проектування освітлювальної установки відкритого простору  

в Calculux 
 

Calculux надає проектувальнику вибір з 19 стандартних відкритих 

просторів для освітлення: 17 з яких є спортивними майданчиками різних 

видів і дві одно- і двосмуговими проїжджими частинами. Разом з вказаним, є 

можливість створення відкритого простору встановлюваних користувачем 

довільних геометричних розмірів. 
 

 

 

Рис. 3.4 – Хід світлових променів  і візуалізація стадіону 
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Алгоритм проектування ОУ відкритого простору розглянемо на 

прикладі освітлення футбольного поля: 

1. Після запуску програми необхідно створити новий проект, для 

чого слід скористатися меню «Файл», вибравши з нього пункт «Новий 

проект» або натискувати на кнопку «Новий» панелі редагування. 

2. Основні команди побудови проекту містяться в пункті меню 

«Дані». На другому етапі з цього пункту можна вибрати підпункт 

«Налаштування проекту». У вікні, що з'явилося, з 9 вкладками 

проектувальник може змінювати налаштування: 

- загальні (встановити коефіцієнт запасу, збереження результатів 

розрахунку); 

- двомірний вигляд (включити/відключити різні параметри для 

двовимірної проекції); 

- тривимірний вигляд (включити/відключити різні параметри для 

тривимірної проекції); 

- симетрія (тут можна встановлювати вид симетрії: відносно осі X, 

відносно осі У, відносно двох осей, що дуже зручно при розміщенні ОП). 

 Ця вкладка також дозволяє встановити положення початку координат; 

- націлювання (Опція використовується при розміщенні світильників в 

просторі. Програмою пропонується включити один їх трьох видів 

націлювання: паралельно площині XY, паралельно площині XZ і 

паралельно площині YZ); 

- двовимірний масштаб (опція настройки масштабу відображення 

побудов для двовимірної проекції); 

- тривимірний масштаб (те ж для тривимірної проекції); 

- імпорт AutoCad (параметри імпорту зображення і £ програми 

AutoCad, тут можна задати одиниці вимірювання об'єкту, що імпортується); 

- експорт AutoCad (параметри експорту даних в AutoCad, тут можна 

вибрати версію AutoCad, в яку будуть експортовані дані, а також задати 

розширення файлу). 

3. З пункту меню «Дані» слід вибрати підпункт «Вибір поля». В 

невеликому за розмірами вікні, що з'явилося, необхідно натиснути кнопку 

«Додати», що дозволить розкрити список пропонованих програмою 

стандартних полів. З цього списку виберемо футбольне поле.  

На екрані з'явиться нове вікно із заповненими за умовчанням 

рядками, значення яких можна змінювати. Змінювати можна: назву поля, 

розміри поля, положення координати центру, поворот поля. У правій 
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частині вікна відображається двомірний план вибраного поля (вигляд 

зверху). Зміни, які вносяться у вказані рядки, викликають зміни 

двовимірного плану.  

Після натиснення кнопки ОК система повертається до невеликого 

вікна, в яке вже додано назву вибраного поля. Виділивши цю назву 

(однократним натисненням на ньому лівої кнопки миші), при необхідності 

можна використовувати решту кнопок, що знаходяться під кнопкою 

«Додати».  

Це кнопки «Змінити» – повернення до завдання параметрів вибраного 

поля; «Дублювати» – створення поля співпадаючого за параметрами із 

заданим раніше, яке буде розташоване з останнім на одному кресленні; 

«Видалити» – видаляє створене поле. 

4. На цьому етапі необхідно вибрати тип світильника або 

світильників, які будуть використані в проекті. Вікно вибору світильників 

викликається з підпункту меню «Вибір світильників» меню «Дані».  

Вікно є подібним до вікна, розглянутого за допомогою декартової 

системи; або Поворот – Нахил  90 – Нахил 0 – при націлюванні за 

допомогою полярної системи; Z-вісь; Х-вісь; Y-вісь. 

Для додавання інформації про потрібний світильник необхідно 

вибрати його за допомогою миші у віконці зверху, після чого натиснути 

кнопку «Новий» внизу. При цьому в таблиці додається перший запис, деякі 

елементи якого можна редагувати. В елементі тип повинна знаходитися 

заголовна буква латинського алфавіту, відповідна букві напроти назви 

світильника з верхнього віконця.  

У відповідних елементах таблиці необхідно задати інформацію про 

положення світильника в просторі, при цьому можна використовувати 

нахил світильника відносно трьох просторових осей, скориставшися 

націлюванням за допомогою RBA.  

Розташування світильника в просторі відбувається після натиснення 

кнопки «Вставити» в нижній частині вікна. Для перегляду картини 

положення світильника в просторі, не виходячи з вікна «Індивідуальні 

світильники», можна здійснити перемикання на другу вкладку «Вигляд». У 

вкладці передбачені можливості переходу між різними дво- і 

тривимірними видами проекцій. Вказані можливості полегшують роботу 

над розміщенням світильників. 
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При виборі підпункту меню «Група світильників» на екрані 

з'являється вже знайоме нам вікно з кнопкою «Додати», натискаючи на яку 

 можна викликати випадаюче меню, що складається з п'яти пунктів: 

1. Блок – додавання світильників блоками. 

2. Полярна – додавання світильників, використовуючи полярну 

систему координат. 

3. Лінія – додавання світильників лініями. 

4. Точка – розміщення світильників, за допомогою вказівки 

координати точки положення його в просторі. 

5. Вільна – відповідає індивідуальному додаванню світильників. 

 

 

3.3. Основи моделювання освітлення в програмі Relux Professional 2007 

 

Загальні відомості 
 

Програма Relux Professional 2007 є частково платним програмним 

продуктом швейцарської компанії Relux Informatic AG. Так до складу 

програмного пакету основної програми Relux Professional 2007 входять ще 

дві підпрограми (PlugIn). Relux Vision – підпрограма для візуалізації 

(трасування проміння) проектів, виконаних в Relux Professional і Relux  

Cad – підпрограма для полегшення спільної роботи Relux Professional і 

Autodesk AutoCad, обидва цих PlugIn-а є платними (в режимі тесту 

пропонується 30 днів безкоштовної роботи). В програмі є можливість 

вибрати одну з сімнадцяти мов інтерфейсу програми і вихідних даних, 

присутня і російська мова. 

Так само як і в DIALux, в основі інтерфейсу лежить розділення 

екрану на декілька функціональних частин: 

У верхній частині – головне меню і лінійка інструментів швидкого 

доступу до команд; 

Зліва Менеджер проекту – деревовидний список всіх елементів 

проекту із закладками до баз даних елементів проекту: меблі, текстури, 

світильники, результати розрахунків; 

У центрі Активне вікно, аналогічне CAD – вікну з DIALux, що є так 

само вікном графічного редактора векторних двовимірних і тривимірних 

зображень; різні види сцени встановлюються клавішею на Лінійці 

інструментів. 
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Запуск програми Relux Professional 2007 
 

1. Подвійне клацання для відкриття групи програм RELUX 2007 з 

меню Пуск -> Програми і подвійне клацання для запуску програми  

RELUX Professional 2007  по її значку. 

2. При завантаженні програми Ви побачите панель запрошення в 

програму. 

3. Після закінчення завантаження в програмі RELUX автоматично 

відкривається панель Асистент проектів освітлення, в якому є 

можливість вибрати декілька варіантів проектів освітлення. У верхній 

частині знаходиться експрес (Express) режим освітлення внутрішнього 

приміщення, в нижній частині в заголовку Проекти є можливість вибрати 

один з трьох проектів освітлення: Внутрішнє приміщення, Вулиця або 

Дорога. Виберіть Внутрішнє приміщення. 

4. Відкриється вікно Ввести проектні дані, в якому можна ввести 

інформацію про проект освітлення. Так в полі Об'єкт вводимо назву 

TEST_ROOM. Натискаємо на OK.  

5. Відкриється вікно по обробці параметрів приміщення. В графі 

Назва приміщення вводимо Office_Room. Встановлюємо розміри 

приміщення: Довжина (Стіна 1): 6.0, Ширина (Стіна 2): 5.0, Висота: 3.0. 

Решту параметрів залишаємо за умовчанням і натискуємо ОК.   

 

Створення геометрії приміщення 
 

В Активному вікні з'явився план створеного нами приміщення. Для 

того, щоб подивитися його тривимірний вигляд можна скористатися 

лінійкою інструментів, клацнувши на 3D-вид, або у верхній частині 

Активного вікна вибрати Вікно -> 3D-приміщення. Тепер відредагуємо 

геометрію приміщення. 

1. Для зручності відтворення геометрії приміщення скористаємося 

опцією Імпорт: Файл -> Імпортувати -> Зображення фону (прописуємо 

шлях, файл Test_room.wmf). Для установки відповідного масштабу 

виконуємо наступні дії: в верхній частині Активного вікна вибираємо 

Зображення -> Зображення заднього плану -> Масштаб встановити. 

Встановлюємо курсор в лівий верхній кут плану і невідривно ведемо до 

лівого нижнього кута приміщення. Відпускаємо кнопку миші і у вікні, що 

відкрилося, Масштабувати зображення фону встановлюємо  

довжину 5.3 м, натискаємо ОК. 
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2. Тепер встановимо нульову точку. Знову звертаємося до вкладки 

Зображення -> Зображення заднього плану -> Нульову точку 

встановити. Клацанням миші вибираємо нульову точку, в нашому 

випадку – лівий нижній кут плану приміщення. 

3. Для роботи з редактуванням геометрії приміщенні іноді вигідно 

користуватися прив'язками. Налаштування прив'язок до сітки можна 

встановити тут: Зображення -> Первинна ширина растру. У вікні 

Характеристики, що з'явилося, знімаємо галочку з  Активувати 

приймальні грати. Якщо Вам зручніше працювати з сіткою, то не 

забувайте, що всі об'єкти будуть прив'язані до її вузлів, але при цьому ви 

можете самі встановити зручну для вас величину сітки. Натискуємо ОК. 

4. Щоб змінити геометрію приміщення необхідно змінити тип 

приміщення з Прямокутне в Багатокутник, для цього в Активному вікні 

клацаємо праву кнопку миші. В меню, що з'явилося, вибираємо 

Перетворити в багатокутне приміщення.  

5. Тепер додаємо нашому приміщенню необхідну геометрію. Спершу 

нам необхідно додати нові точки: наводимо курсор миші на контур 

приміщення, правою кнопкою миші у випадному списку вибираємо 

Кутову точку ввести. Потім клацанням миші вибираємо місце вставки 

точки на контурі – якщо все правильно, на ньому з'явиться чорна 

квадратна точка. За допомогою миші переміщаємо точку в необхідне 

місце. В нашому випадку це дві точки з правого боку приміщення знизу і 

зверху. 

6. Геометрія готова.  

 

Порада: Не забувайте зберігати проект на кожній стадії роботи. 

Наприклад, збереження у файл (Relux_test.rdf) 

 

Матеріали і текстури 
 

Тепер, коли геометрія приміщення готова, самий час привласнити 

його поверхням текстури і матеріали для правильного розрахунку 

розподілу світла і візуального сприйняття. 

1. У «Менеджері проекту» вибираємо закладку Проект -> Підлога. 

Перед нами з'явиться вікно Характеристики, тут ми можемо поміняти 

назву виділеного фрагмента приміщення графа Позначення, привласнити 

матеріал і текстуру внутрішній або зовнішній стороні виділеного 
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фрагмента приміщення. Натискуємо на кнопку Матеріал/Текстура в                           

області / Внутрішня сторона.  

2. У вікні, що відкрилося, Матеріали обробити нам пропонується 

вибрати матеріал із стандартного набору. В правій стороні вікна 

Матеріали обробити ми можемо спостерігати фотометричні властивості 

вибраного матеріалу: Color – колір матеріалу, зміна якого призводить до 

зміни Rho – середнього коефіцієнта відбиття, Surfacefinish – відбиваючі 

властивості матеріалу (впливає тільки на процес формування 

фотореалістичного зображення в результаті трасування проміння). 

3. Якщо нас не влаштовує список стандартних матеріалів, то 

натискуємо на Add, відкриється вікно Select materiall, в якому можна 

вибрати текстури і матеріали таким чином:  

Basic materials – список стандартних матеріалів, причому список 

ділиться на дві частини. Перша частина Relux standart materials – 

створення стандартних дифузних матеріалів без текстур (Diffus) і (Bild) – 

створення дифузних матеріалів з можливістю вибору текстури з файлу 

*.jpg, *.bmp, *.gif. Друга частина Vision materials – створення складних 

фотометричних матеріалів під трасування проміння: метал, просте скло, 

складне скло з індексом заломлення, дзеркало, напівпрозорий матеріал.  

Texture library – детальна бібліотека готових текстур і матеріалів 

(дифузні). 

Vision materials – бібліотека готових текстур і матеріалів з 

фотометричними властивостями, призначених для подальшого трасування 

проміння. 

Інші дві закладки вікна Favorites і Last time used – бібліотеки, в яких 

зберігаються вибрані матеріали/тектури і ті, які ви використовували 

останнім часом. 

4. Вибираємо пункт Vision Materials -> Materialarten, вибираємо 

Holz -> Parkette -> Buche Parkette. Натискаємо ОК. 

5. Аналогічно необхідно вибрати текстуру Стін і Підлоги. 

6. Для всіх стін привласнимо матеріал Vision Materials -> 

Materialarten -> Putze -> Rauher Putz -> Verwaschener Putz. 

7. Для стелі Vision Materials -> Materialarten -> Holz -> Holz 

allgemein -> Birke. 

8. Вибрані матеріали і текстура з'являться у вікні Менеджера 

проектів. Звертаємо увагу, що матеріал відобразиться тільки після 

візуалізації. 
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Порада: Щоб привласнити однаковий матеріал і текстуру всім 

стінам або їх набору одночасно, необхідно в Менеджері проекту виділити 

необхідні стіни з натиснутою кнопкою Shift або Ctrl. 

 

Розміщення меблів і об'єктів 
 

Переходимо до облаштування приміщення.  

Порада: Клацнувши двічі мишею на будь-які меблі, відкривається 

вікно Характеристики для зміни параметрів об'єкту. 

1. У Менеджері проекту вибираємо закладку Об'єкти -> Елементи 

приміщення -> Вікно. Шляхом буксирування встановлюємо в приміщення 

Вікно. Активне вікно повинне бути в режимі 3D-вида. 

2. Параметри Вікна у вікні Характеристики: Ширина = 4.0, 

Висота = 1.2, Відстань зліва (X')= 0.5, Відстань знизу (У‘)= 1.3. 

3. Привласніть Вікну матеріал і текстуру з бібліотеки Vision 

Materials на ваш смак.  

4. Розверніть вигляд так, щоб було зручнішим розташовувати двері 

на протилежній вікну стіні. 

5. Розкрийте закладку Об'єкти -> Елементи приміщення і виберіть 

Двері. Буксируванням перенесіть її із списку в приміщення. 

Використовуючи потрібний вигляд і операцію переміщення, встановіть 

двері в потрібне місце. Параметри Дверей у вікні Характеристики:  

Ширина = 1.4, Висота = 2.2, Відстань зліва (X‘) = 0.65, Висота  

знизу (У‘) = 0.0. 

6. Привласніть Дверям матеріал і текстуру з бібліотеки Vision 

Materials на ваш смак. 

7. Розкрийте закладку Об'єкти -> 3D об'єкти/Меблі -> Додати. У 

вікні, що з'явилося, виберіть Shelves/cupboards, клацаємо двічі, вибираємо 

Armoire 2/ Натискуємо Прийняти. Вибрана шафа відобразилася в 

Менеджер проекту. Буксируванням перетягуємо її в Активне вікно. 

Розташуйте шафу поряд з Дверима створками всередину приміщення.  

8. На вигляді зверху (План) кнопка F2, розташуйте шафу згідно 

плану. 

9. У вікні Характеристики: Масштабування: X: 2.1, У: 1.5, Z: 1.4. 

10. Аналогічним чином з бібліотеки вибираємо інші меблі і 

розміщуємо в приміщенні: робочий стіл, стілець і ноутбук – згідно плану. 
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11. Для зручності розміщення користуйтеся виглядом Зверху  

і 3D-видом. Для коректування місця розташування користуйтеся 

властивостями Обертати (Ctrl+R) і Переміщати (Ctrl+E).  

12. Як тільки сформовано одне робоче місце, виділяємо об'єкти, що в 

нього входять: стіл, стілець, ноутбук. Клацаємо праву кнопку миші і 

вибираємо Об'єкти групувати. Таким чином, ми маємо новий об'єкт 

(групу), яка відображатиметься на вигляді Зверху, як Група 1. 

13. Виберіть клацанням Група 1. У вікні Характеристики, що 

з'явилося, в графі Позначення напишіть Робоче місце. Групи автоматично 

індексуються, тому немає потреби дописувати номер групи. 

14. Для зручності розміщення меблів можна на згруповані об'єкти, 

що знаходяться вже в Активному вікні, клацнути правою кнопкою миші і 

вибрати Об'єкт розмістити в ряд. Вкажіть мишею напрям копіювання і 

кінцеву точку. Після того, як Ви відпустите кнопку, відкриється вікно 

Характеристики, в якому можна задати опції копіювання. 

15. Додаємо в сцену стіл для переговорів, наприклад (meeting table 1). 

16. Розставляємо всі меблі в приміщенні згідно плану. 

17. Зберігаємо проект. 
 

Сцени освітлення 
 

Програма Relux має нагоду розраховувати, як штучне освітлення, так 

і природне. Для того, щоб це стало можливим, створимо Нову сцену.  

1. Для цього необхідно скопіювати готове приміщення. В головному 

меню вибираємо пункт Проект -> Подвоїти сцену. 

2. За допомогою головного меню Проект -> Редагувати сцену 

замінюємо назву приміщення у відповідній графі, наприклад на 

(Test_room_nature). 

3. Перемикання сцен здійснюється в кнопковому меню Сцена, тут же 

можна бачити, яка сцена активна. 

Отже, одна сцена призначена тільки для розрахунку природного 

світла (Test_room_nature), а в іншій розставимо світильники і будемо 

розраховувати штучне світло і/або комбіноване (Test_room). 
 

Розрахункові площини 
 

Щоб зробити якісний проект освітлення, нам необхідно 

дотримуватися відповідних норм з кількості і якості світла, що 

регламентуються в нормативних документах (ДБН, МГСН, DIN EN і т.д.). 
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1. Для цього треба ввести площини, в яких одержуватимемо 

результати розрахунку світлотехнічних величин. 

2. У Менеджер проекту відкриваємо закладку Об'єкти -> 

Вимірювальні елементи, вибираємо Віртуальна вимірювана поверхня.  

3. Перетягуємо розрахункову площину на поверхню одного робочого 

столу, розташованого біля вікна. Стандартна площина має прямокутну форму. 

4. Клацаючи двічі по розрахунковій площині, переходимо у вікно 

Характеристики. 

5. У графі Позначення пишемо Робочий стіл і змінюємо тип 

поверхні з прямокутної на багатокутну за допомогою спадаючого меню. 

6. Встановлюємо необхідну висоту розрахункової поверхні так, щоб 

вона розташовувалася на столі. 

7. Внизу цього ж вікна ви знайдете закладку Розрахунок, в якій 

можна встановити параметри розрахунку світлових характеристик на цій 

площині (горизонтальна, вертикальна освітленість, розрахунковий растр, 

показник дискомфорту і т.д.).  

8. Там же виберіть Горизонтальна освітленість. 

9. Використовуючи мишу, по точках додайте площині необхідний 

розмір, відповідний розмірам столу. 

10. Створіть аналогічну розрахункову поверхню і розмістіть її на 

поверхні клавіатури ноутбука. 

11. Аналогічним способом розташуйте розрахункову площину на 

поверхні столу для переговорів. Дії по зміні геометрії розрахункової 

поверхні аналогічні зміні геометрії приміщення. 

Порада: Клавіатура в даному випадку є робочою зоною, а стіл – зона 

безпосереднього оточення. Горизонтальна освітленість цих зон повинна 

бути 500 і 300 люкс відповідно, причому нерівномірність освітлення 

робочої зони – більше або рівна 0,7, а зони оточення – не менше 0,5. 

 

Вибір і розміщення світильників 
 

Тепер можна приступати до вибору і розстановки світильників.  

1. У Менеджер проекту виберіть закладку Об'єкти ->  

Світильники -> Додати. 

2. Відкриється вікно Вибір світильників, активуйте закладку 

Окремий світильник. 

3. Пропишіть шлях до файлу (Light_fixtures_Test.LDT), який 

знаходиться на диску в теці Relux. 
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4. Натисніть Новий, потім ОК. 

5. Вибраний світильник пропишеться в Менеджері проекту. 

6. У програмі передбачено декілька способів швидкого розміщення 

однотипних світильників.  

7. Можна розміщувати світильники по лінії, колу, рівномірно або 

відображати один щодо одного. 

8. Для цього буксируванням перетягніть світильник з «Менеджера 

проекту» на план. 

9. У Менеджері проекту виберіть закладку Проект, клацніть на 

потрібний світильник правою кнопкою миші і виберіть Групувати. 

10. Інший спосіб – це Zonal Cavity, який пропонує потрібну кількість 

світильників виходячи з необхідної освітленості, коефіцієнта запасу (коефіцієнт 

технічного обслуговування), способу монтажу та інших параметрів. Його 

можна викликати з головного меню Світильники -> EasyLux або з лінійки 

інструментів. В нашому випадку ми скористаємося саме ним.  

11. У вікні, що з'явилося, в графі Вид монтажу ставимо Стельовий 

монтаж. Решту параметрів залишаємо без змін. Натискуємо ОК.  

12. Світильники виявляються розставленими – це видно в Активному 

вікні. Для редагування розстановки світильників, не знімаючи виділення, 

ввійдіть знову в меню Світильники -> EasyLux. 

Порада: Програма Relux рівнозначно розуміє файли з описом 

світильників, як у форматі IES, так і в LDT. 
 

Обчислення 
 

Після розстановки світильників наше приміщення готове до 

розрахунку світлотехнічних параметрів. 

1. У першу чергу необхідно перевірити коректність геометрії 

приміщення і розстановки меблів. Це просто зробити, вибравши з лінійки 

інструментів кнопку Приміщення перевірити. З'явиться вікно Перевірка 

зіткнень, в якому буде автоматично відображена інформація про 

коректність побудови сцени. 

2. У головному меню вибираємо пункт Розрахунок -> Менеджер 

розрахунку. 

3. Встановимо «галочки» в приміщенні з світильниками навпроти 

Штучне освітлення. Справа відкриється вікно налаштувань розрахунку, 

при вибраній знизу закладці Розрахунок. Точність – є можливість вибрати 

один з чотирьох варіантів розрахунку по точності. Перший варіант – 
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Тільки пряма складова – грубий розрахунок розподілу освітленості по 

сцені, враховується тільки пряме світло від світильника, немає обліку 

багаторазового відбиття. Четвертий варіант – Висока складова відбитого 

світла – точний розрахунок, як прямої складової світла від світильника, 

так і перевідбиттів в сцені між поверхнями. Використовується в основному 

в світлих приміщеннях з великим коефіцієнтом відбиття поверхонь або у 

випадках, коли вимагається одержати максимально точний розрахунок 

світлотехнічних величин. Варіанти Невелика і Середня відбиті складові – 

є проміжними. Растр – параметри установки розрахункової сітки (растр). Є 

як автоматичний режим, так і ручний. Зміни параметрів розрахункової 

сітки в ручному режимі можуть негативно позначитися на часі розрахунку. 

Коефіцієнт технічного обслуговування – встановлюється коефіцієнт 

зниження освітленості в сцені залежно від чистоти і технічного 

обслуговування приміщення. За умовчанням встановлено значення 0.8. 

4. У закладці Вимірювані поверхні знаходиться список поверхонь з 

параметрами розрахункової сітки, на яких будуть проводиться розрахунки. 

5. У закладці Оцінка засліпленості, можна встановити параметри 

віртуального спостерігача для визначення показника дискомфорту, в 

даному випадку європейського аналога (UGR – Unifay Glare Range). 

Параметри спостерігача наступні: X(m): 0.5, У(m): 2, Z(m): 1.7. 

6. Переходимо до другого приміщення Test_room_nature. Встановимо 

галочку навпроти Денне світло. В пункті Денне світло відкриються 

характеристики розрахунку. Перша закладка Розрахунок аналогічна 

закладці Розрахунок для штучного світла. Добалена графа – Небо, можна 

вибрати одну з двох моделей небозводів: Похмуре небо по CIE або Ясне 

небо по CIE. Відмінність в появі прямої складової сонячного проміння.   

7. Встановіть Похмуре небо по CIE. 

8. Вибираємо закладку Дата, встановіть поточну дату і час (Дата, 

Місцеве).  

9. Натискайте кнопку Місце розташування. Встановіть:  

Широта – 55,7°,  Довгота 37,6°.  

10. У шапці списку міст напишіть Moscow і натискайте Взяти нове 

значення в лист розміщення. Натискаємо ОК. 

11. Натискаємо кнопку Північний кут. У вікні, що з'явилося, можна 

регулювати положення приміщення відносно півночі. В нашому випадку 

залишимо значення за умовчанням – 0.   

12. Натискуємо кнопку Старт. 
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Після закінчення розрахунків проаналізуйте результати 
 

1. Відкрийте повторно Менеджер розрахунку, зніміть галочок з  

Штучне освітлення і Денне світло, встановіть галочок напроти Relux 

Vision.  

2. У вікні налаштувань Relux Vision виберіть закладку Види, 

встановіть по одному довільному вигляду в кожній сцені.  

3. Натискуємо кнопку Старт.  

4. Порівняйте одержані результати. Relux дозволяє розраховувати 

суміщене освітлення (поєднання штучного і природного освітлення). 

Такий розрахунок, наприклад, може бути корисний для аналізу систем 

управління освітлення або розрахунку рентабельності освітлювальної 

установки в умовах наявності великої кількості природного світла в 

приміщенні. Проведемо такий розрахунок для приміщення Test_Room. 

5. Для розрахунку комбінованого освітлення (природне + штучне), 

заходимо в Менеджер розрахунку і встановлюємо галочку поряд з 

штучним і природним освітленням. 

6. Зберігаємо проект. 

Порада: Для візуального аналізу розподілу світла по сцені виберіть 

на лінійці інструментів Розподіл яскравості в 3D. 

 

Економічний аналіз 
 

Програма Relux Professional 2007 дозволяє в автоматичному режимі 

провести оцінку економічної вигоди за рахунок використовування 

природного світла в приміщенні. Для цього:   

1. У головному меню вибираємо Розрахунок -> Економічність -> 

Денне світло -> Задані величини. 

2. У меню Задані дані виставляємо необхідні значення експлуатації 

приміщення в перебігу року: робочий час, час відпусток, перехід на 

літній/зимовий час, необхідну освітленість, коефіцієнт природної 

освітленості. Всі параметри залишаємо за умовчанням. Натискуємо ОК. 

3. Далі вибираємо Денне світло -> Вірогідність сонячного світла. 

З'являється вікно Сонячна правдоподібність, з назви вікна зрозуміло, що 

йдеться про процентну вірогідність попадання прямого сонячного 

проміння у вікно по місяцях. На жаль, від місце розташування 

приміщення, орієнтації на північ ці дані мінятимуться і окрім як 

емпіричним шляхом їх не обчислити, тому скористаємося  
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кнопкою DIN-стандарт, яка виставить всі значення вірогідності на 40%. 

Натискуємо ОК. 

4. Вибираємо Денне світло -> Освітлювальний пристрій. З'являється 

вікно Освітлювальний пристрій, в який слід внести параметри світильника, 

що використовується нами: кількість світильників: 6, споживання потужності 

на світильник: 56Вт, Вартість за кВт/год: 2. (вартість електроенергії на 

поточний час). Натискуємо ОК. 

5. Вибираємо Денне світло -> Ізолюкс лінії. З'являється вікно 

Розподіл в ізолюксах, в якому можна міняти порогові значення ізоліній. 

Залишаємо значення за умовчанням. Натискуємо ОК.  

6. Вибираємо Денне світло -> Розрахувати.   

7. У Активному вікні з'являться результати економічного 

розрахунку. Самостійно проаналізуйте дані і зробіть висновки.  

8. Якщо в розрахунковому приміщенні знаходяться світильники двох 

і більше типів, то з допомогою Розрахунок -> Економічність -> Штучне 

освітлення можна просто і наочно порівняти типи світильників, що 

використовуються, у вигляді таблиці і вибрати найекономічніший 

світильник. Для цього у вікні Економічність світильника, виберіть 

кількість порівнюваних світильників і на кожному натискайте Обробити, 

заповніть пропоновані графи. Точність вказаних даних впливатиме на 

результат порівняння.     

Порада: Ізолінії в основному використовуються в графічному 

відображенні розподілу освітленості на поверхні або групі поверхонь. 

Програма Relux використовує в світловому аналізі Коефіцієнт Природної 

Освітленості (КПО) – відношення природної освітленості, створюваної в 

деякій точці заданої площини усередині приміщення світлом неба 

(безпосереднім або після відбиття), до одночасного значення зовнішньої 

горизонтальної освітленості, створюваної світлом повністю відкритого 

небозводу, вимірюється у відсотках. По діючих нормах [3] КПО в 

суспільних робочих приміщеннях повинне бути не нижчим 1%. Значення 

КПО за умовчанням у програмі рівне 5%. 
 

Аналіз і збереження результатів 
 

1. Після закінчення розрахунку в Менеджері проекту, вибираємо 

закладку Вихідні дані і аналізуємо результати на розрахункових 

поверхнях, а також в просторі приміщення з використанням фіктивних 

кольорів. 
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2. Далі встановіть «галочки» в пунктах: Дані світильника, 

Креслення горизонтальної поверхні, Огляд результатів (на всіх 

розрахункових поверхнях), 3D псевдокольори -> Освітленість ->           

3D вид 1, Vision результати на двох видах. Виберіть й інші вихідні дані, які 

допоможуть Вам оцінити результат освітлення. 

3. У меню Активного вікна вибираємо пункт Обробити -> Вид 

друкувати, у вікні, що відкрилося, вибираємо всі сторінки і формат *.PDF. 

Можна вибрати принтер, який є у розпорядженні, тоді результати 

розрахунку будуть надруковані на папері. 

4. Далі натискуємо Друк і зберігаємо результати в свою теку. У 

результаті Ви одержите єдиний PDF-файл зі всіма виділеними 

світлотехнічними результатами. 

 

Робота з ReluxCAD 
 

У даному розділі спробуємо провести геометричні побудови 

приміщення Test_Room засобами ReluxCAD. Для цього нам потрібна 

програма AutoCAD версії після 2005.   

1. Запускаємо AutoCAD. 

2. Відкриваємо файл «Draw_Test_Room.dwg» 

3.У лінійці інструментів з'явилася панель ReluxCAD. 

4. Необхідно створити новий проект, скориставшися кнопкою Project 

на цій панелі.  

5. У вікні, що відкрилося, вибираємо Create і зберігаємо файл у вашу 

теку.  

6. Перевіряємо, щоб в меню Scaling стояли «1» в обох графах. Це 

говоритиме, що ми працюємо в масштабі 1:1. Натискуємо Close. 

7. У лінійці AutoCAD відкриваємо Диспетчер властивостей шарів і 

створюємо новий шар, наприклад (RLX_1), і вибираємо його поточним.  

8. Вибираємо кнопку Draw room і обводимо приміщення на плані. 

Коли контур замкнутий, натискуємо праву кнопку миші або Enter.  

9. У вікні Create, що з'явилося, вводимо: назва приміщення Name: 

Test_room_ReluxCAD, висоту приміщення Room height(m): 3, Висоту 

тексту Text height встановлюємо рівній одиниці (0.2).  

10. Натискуємо кнопку Select room, і натискуємо Start Relux. 

11. Тепер можна бачити, як наше приміщення виглядатиме в 

програмі Relux. 
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12. Виберіть будь-який об'єкт в Менеджері проектів, розмістіть в 

Активному вікні, наприклад це може бути стіл для переговорів. 

13. Поверніться в AutoCAD, натисненням кнопки із значком 

AutoCAD на лінійці інструментів в Relux. 

14. Вибираємо в лінійці інструментів Import 3D project.  

15. Перевіряємо правильність шляху файлів і його властивості. 

Натискуємо Insert. Таким чином, вміст файлу Relux перенісся 

(синхронізувався) з AutoCAD. Є й інша можливість – переносити 3D 

об'єкти з AutoCAD в проект Relux. Для цього: 

16. Вибираємо на панелі Export 3D object, у вікні, що відкрилося, 

натискуємо кнопку Select object. Виділяємо курсором елемент меблів, 

натискуємо праву кнопку миші Copy to clipboard -> Close. 

17. На панелі вибираємо Select room, натискуємо Relux у вікні, що 

з'явилося, відкривається Relux, в меню вибираємо Обробити -> Додати. 

Об'єкт з'явиться в Менеджері проектів. Повертаємося в AutoCAD. Додаємо 

світильники. 

18. Натискуємо на панелі Luminare selection/Single placing.  

19. У вікні, що відкрилося, натискуємо Select luminaries і як в Relux 

вибираємо світильник  Light_fixtures_Test.LDT. Для введення одного 

світильника в тому ж вікні натискуємо кнопку Plase Single luminaire. 

Мишею позначаємо початкову точку розташування і поворот світильника.  

20. Для створення групи світильників в кнопковому меню 

натискуємо Place Luminare group. Мишею позначаємо лінію, уздовж якої 

проводитимемо копіювання світильників.  

21. Після завершення у вікні, що відкрилося, вводимо параметри 

копіювання.  

22. Вибираємо кількість і спосіб розстановки на свій розсуд.  

23. Запропонуйте свою концепцію освітлення. 

24. Переходимо в Relux і проводимо розрахунок. 

25. Повертаємося в AutoCAD. 

26. У лінійці інстументов вибираємо Select room і у вікні Relux 

interface, натискуємо кнопку Insert overview, Insert Isolines, Insert table. 

Таким чином, на кресленні в AutoCAD відображаються світлотехнічні 

результати. 

27. Зберігаємо одержане креслення. 
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Налаштування програми Relux 
 

Основні налаштування програми і величини, що використовуються 

за умовчанням, можна змінити за допомогою: Головне меню -> Екстра. 

Таким чином, можна змінити початкові установки програми, включаючи 

використану мову інтерфейсу, бази даних і вихідної документації.  

Для самоконтролю рекомендується користуватися файлом 

«Relux_test.rdf», що знаходиться в архіві Relux2007.zip. 

 

3.4 Проектування в програмі Lightscape версії 3.2 
 

Інтерфейс програми Lightscape складається з Графічного вікна, 

Панелі шарів, Панелі матеріалів, Панелі блоків і Панелі світильників. 

Графічне вікно використовується для відображення і редагування робочої 

сцени. За умовчанням вона розташовується в лівій частині екрану і займає 

його значну частину. Чотири вказані панелі зібрано разом в правій частині 

екрану. Користувач може за бажанням змінити їх розташування і розміри. 

Доступ до команд редагування здійснюється через панель 

інструментів, головне меню і контекстне меню клацанням правої миші. 

Для деяких команд редагування з'являються додаткові спливаючі панелі 

діалогу. 

Поради:  

1. Спливаюча підказка виникає при установці курсора миші на  

будь-якій з клавіш і указує на назву клавіші. 

2. Змінюйте розмір вікон залежно від зручності роботи, але 

пам'ятайте, що параметри вікон і їх розмір зберігається після виходу з 

програми. 
 

Завантаження тривимірної сцени 
 

Особливістю програми Lightscape є те, що вона має обмежений набір 

інструментів для роботи і редагування 3D-сцен. В основному вона 

використовується як інструмент з розрахунку освітлювальних установок 

на основі вже раніше створених моделей в будь-якому з 3D - редакторів. 

Програма розпізнає чотири формати даних: 3ds, Dwg, Dxf і Lightwave 

(*.lws), при цьому після імпорту моделі в Lightscape, вона перетвориться в 

свій власний формат файлу Lightscape Preparation (*.lp).  

1. Відкрийте теку Lightscape, що знаходиться в архіві Lesson 

Lightscape.zip. 
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2. Завантажте файл у форматі Lightscape Preparation – Test_Room.lp. 

Lightscape виведе на екран зображення невеликої галереї мистецтв, з 

розташованими в ній джерелами і картинами в рамках на стіні. 

 

Використання миші 
 

У програмі Lightscape використовується двокнопкова миша. 

Обумовлено це тим, що остання доробка програми здійснювалася в 1999 р. 

Ліва кнопка миші є командною, а права кнопка викликає контекстне меню. 

При переміщенні натискуючої лівої кнопки миші в Графічному вікні 

реакція Lightscape залежить від режиму: 

Режим вибору – вибір об'єктів в сцені. 

Режим запиту – при клацанні по об'єкту на інформаційній смузі 

з'являється інформація про цей об'єкт. 

Режим динамічного огляду – залежно від вибору інструменту 

управління відображенням Orbit (Орбіта) або Rotate (Поворот) 

буксирування миші призводить до безперервної зміни зображення сцени. 

Режим спеціального вибору – деякі операції в Lightscape вимагають 

специфічних дій миші: наприклад, можна використовувати режим вказівки 

(Pick mode) в Transformation dialog (Діалог перетворень) для націлювання 

світильників. Режим спеціального вибору виходить з діалогу, пов'язаного з 

виконуваною операцією. 

Клацання правою кнопкою миші призводить до появи контекстного 

меню, що містить команди відповідно до вибраного об'єкту або вікна. 

Наприклад, праве клацання в Графічному вікні при вибраній поверхні 

висвічує команди операцій роботи з поверхнями. 

Панель шарів – кожний об'єкт в Lightscape належить певному шару, 

і Панель шарів висвічує імена і стан шарів. Установка прапорця лівим 

клацанням миші зліва від імені об'єкту призводить до того, що шар і 

об'єкти, що належать йому, відображаються в Графічному вікні. Подвійне 

клацання мишею на імені шару перемикає його стан. Праве клацання на 

імені шару висвічує меню операцій з шаром. 

Панель матеріалів – список матеріалів доступних до використання 

в даній сцені. Подвійне клацання на імені матеріалу активізує Діалог 

властивостей матеріалу, що містить засоби з їх зміни. Контекстне меню 

при правому клацанні миші містить команди роботи з вибраними 

матеріалами. 
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Панель блоків – список блоків, що містяться в поточній сцені: 

блоком в Lightscape є група поверхонь і/або інших блоків, що мають 

загальне ім'я і точку загального центру. Подвійне клацання на імені блоку 

вимикає з сцени всі поверхні і об'єкти, окрім тих, що входять в цей блок 

для ізольованого відображення його на екрані і редагування. 

Панель світильників – список світильників, що містяться в поточній 

сцені: світильником в програмі є спеціальний блок, що характеризується 

розподілом світла в просторі. Подвійне клацання на імені світильника 

вимикає з сцени всі поверхні і об'єкти окрім вибраного світильника для 

його ізольованого відображення на екрані і активізує діалог редагування 

його фотометричних характеристик. 

 

Відображення сцени 
 

Користувач має повний контроль над відображенням сцени на екрані 

в Графічному вікні: управління режимом відображення, виглядом і 

проекцією. Включення всіх інструментальних панелей здійснюється таким 

чином: 

1. Головне меню -> Tools -> Toolbars – з'явиться діалог управління 

інструментальними панелями. 

2. Подвійним клацанням миші встановіть прапорці напроти імені 

всіх інструментальних панелей. 

3. Натисніть Close. 

 

Повне відображення сцени в різних проекціях 
 

Часто при роботі з програмою буває бажання відобразити в 

Графічному вікні одразу всю сцену. Для цього в програмі є наступні 

засоби: 

1. Головне меню -> Display -> Show Axis – в лівому нижньому кутку 

Графічного вікна відобразяться осі системи координат. 

2. Головне меню -> View -> Projection -> Perspective або натиснути 

на клавішу Perspective в панелі інструментів. 

3. Головне меню -> View -> Extents або натиснути на клавішу View 

Extents – при відображенні в центральній проекції (перспектива) View 

Extents розташує сцену відповідно до вигляду спереду. 

4. Окрім центральної проекції користувач може відобразити модель в 

одній з шести ортогональних проекцій: наприклад, View -> Projection -> 
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Top або натиснення по клавіші Top відображає сцену у вигляді плану або 

зверху. 

5. Для повернення до центральної проекції натискайте знову клавішу 

Perspective. 

 

Порада: При ортогональній проекції операція View Extents просто 

масштабує сцену для якнайкращого відображення у Графічному вікні. 

 

Інтерактивне управління відображенням сцени 

 

1. Головне меню -> View -> Interactive -> Orbit або натиснути 

клавішу Orbit – можливо тільки в режимі центральної проекції. 

2. Розташуйте курсор миші в довільному місці Графічного вікна, 

натискайте ліву кнопку миші і буксируйте курсор спочатку по вертикалі, 

потім по горизонталі. Зверніть увагу на зміну зображення сцени на екрані 

відповідно до ваших дій. Таку зміну прийнято називати орбітальним 

переміщенням центру проекції (Orbiting). 

 

Установка режиму відображення сцени 
 

1. Головне меню -> Display -> Wireframe або натискайте на кнопку 

Wireframe (Каркас) – каркасне представлення сцени є найшвидшим, проте 

у разі складних сцен вона важка для сприйняття. Інші режими більш 

наочні, але вимагають значних ресурсів комп'ютера, що може привести до 

«сіпань». 

2. Головне меню -> Display -> Solid або натискайте на кнопку Solid 

(Суцільний режим). 

3. Проведіть орбітальне (Orbit) перетворення сцени – режим дуже 

наочний, проте всі перетворення сцени відбуваються значно повільніше. 

4. Для великої наочності сцени виберіть Display -> Outlined або 

натискайте на кнопку Outlined (контурування) – результат схожий на 

суцільний режим, але всі ребра в сцені виділені. 

5. Натискайте на кнопку Solid. 

6. Можна поліпшити відображення, як в суцільному режимі, так і 

при контуруванні, додавши тонування. Ефект аналогічний тому, що сцена 

освітлюється фарою, встановленою на Вашій камері. 

7. Головне меню -> Display -> Enhanced або натискайте на кнопку 

Enhanced – ця опція може бути включена завжди. 
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8. Натискайте на кнопку Enhanced для виключення режиму 

тонування. 

9. Відзначте, що при орбітальному перетворенні сцени деякі 

поверхні періодично то зникають, то з'являються. Ця процедура 

називається вибраковуванням нелицьових граней: поверхні, орієнтовані 

проти Вашого погляду, видаляються з дисплея. 

10. Головне меню -> Display -> Culling або натискайте на кнопку 

Culling для відключення фонового вибраковування. 

11. Натискайте на кнопку Culling для включення вибраковування 

знову. 

12. Головне меню -> View -> Display Original View для відкриття 

початкового зображення. 

 

Інтерактивні засоби управління дисплеєм 
 

1. Панорамування: 

Головне меню -> View -> Interactive -> Pan або натискуйте на 

кнопку Pan. 

Помістіть курсор в довільне місце Графічного вікна і буксируйте 

його спочатку горизонтально, а потім вертикально. Наголосіть на змінах 

вигляду, які прийнято називати панорамуванням. 

2. Найкращий спосіб активізації різних функцій управління           

екраном – тримати натиснутою на клавіатурі деяку клавішу і буксирувати 

курсор миші. 

Значення деяких ключів: 

O – Orbit                               R – Rotate          Z – Zoom            P – Pan 

D – Dolly (візок)                  S – Scroll           T – Till (нахил) 

Режим включається тільки при натиснутій клавіші, при її відпусканні 

програма повертається до початкового перед натисненням режиму. 

Вибраний режим можна включити постійно, натискаючи клавішу Shift на 

клавіатурі. 

Натискуйте Shift+O для вибору режиму Orbit. 

Після завершення експериментування поверніться до початкового 

зображення Головне меню -> View -> Display Original View. 

3. Масштабування сцени Zoom Window (Наїзд) працює іншим чином: 

Головне меню -> View -> Interactive -> Zoom Window або натискайте 

на кнопку Zoom Window. 

Намалюйте в графічному вікні прямокутник Zoom. 
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Для відновлення попереднього зображення виберіть View -> 

Interactive -> Undo Zoom Window або натискайте на кнопку Undo Zoom 

Window. 

 

Робота з матеріалами 
 

Оскільки Lightscape базується на точному моделюванні процесів 

перерозподілу випромінювання світла, то визначення властивостей 

матеріалів є найважливішим етапом у створенні тривимірної сцени. 

1. Створення нового матеріалу: 

Праве клацання на Панелі матеріалів і вибір Create: в панелі 

додається ще один матеріал, новий матеріал, названий (Item17). Далі 

можна ввести ім'я для матеріалу. 

Введіть FLOOR_WOOD і натисніть Enter. 

2. Двічі клацніть на матеріалі FLOOR_WOOD – з'явиться діалог 

визначення характеристик матеріалу. За допомогою Фотометричної 

(Physics) панелі, що з'явилася, користувач може визначити різні 

характеристики матеріалів. Почати краще всього з вибору Шаблону 

(template), який якнайповніше відобразить властивості вибраного 

матеріалу і допоможе встановити значення параметрів, що Вас цікавлять. 

3. Виберіть Wood Varnished (Лакована деревина) із списку шаблонів. 

Відразу зміняться Блиск (Shininess) і Показник заломлення (Refractive 

Index). Уздовж повзунків (sliders) зміни різних параметрів матеріалу 

проведені червоні і зелені лінії: зелена лінія окреслює реальний діапазон 

зміни відповідного параметра. 

4. Натисніть на закладку Color. Повзунок Величина (Value) визначає 

середній і максимальний коефіцієнт відбиття матеріалу. Зелена і червона 

лінії визначають діапазон зміни коефіцієнта відбиття для лакованої 

деревини. Відзначимо, що повзунки зміни Тону (H, Hue) і Насиченості (S, 

Saturation) не мають кольорових ліній. Це означає, що можливе їх 

довільне значення. 

5. Переміщуйте повзунок Value і проаналізуйте, як змінюється 

коефіцієнт відбиття: для поверхні однорідного кольору середнє і 

максимальне значення співпадають. 

6. Багато матеріалів мають текстуру. Дерев'яна підлога є гарним 

прикладом такого матеріалу. Для визначення текстури необхідно задати 

відповідний растровий файл (практично будь-який графічний файл). 

Виберіть закладку Texture. 
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Натисніть Browse (Перегляд). 

Двічі клацніть на Woodfloor.jpg в списку імен файлів (File Name) для 

завантаження текстури. 

7. Повзунок Brightness (Яскравість) визначає середню і максимальну 

величину відбиття. Оскільки Brightness вибраної текстури ззовні 

рекомендованого діапазону значень, то середнє відбиття матеріалу, що 

виводиться внизу панелі діалогу, знаходиться в червоній зоні. Встановіть 

для Brightness значення 0.25, так що Avg. Reflectance (Середнє відбиття) 

буде близько 0.21, а Max Reflectance близько 0.25. Для карти текстур 

середнє і максимальне значення можуть розрізнятися, важливішим є 

середнє значення. 

8. Включіть Fixed Size і введіть значення – 3(метри) для обох 

вимірювань Width (Ширина) і Height (висота). 

9. Виберіть закладку Color. При використанні текстури коефіцієнт 

відбиття матеріалу встановлюється по яскравості текстури, інакше по 

значенню Value кольору. Відзначимо, що якщо завантажена карта текстур 

для повзунка Value, відсутні зелені і червоні лінії. Якщо користувач 

відключить відображення текстури на сцені, то поверхня, яка використовує 

цей матеріал,  відображатиметься з середнім кольором текстури. 

10. Натисніть кнопку Texture Average (Середня текстура), щоб 

встановити колір матеріалу рівним середньому кольору використаної 

текстури. 

11. Виберіть закладку Physics. 

12. Встановіть повзунок Shininess на значення 0.90. Це визначає 

величину блиску підлоги при трасуванні проміння. 

13. Натискайте OK для установки нових параметрів матеріалу. 

Матеріал FLOOR_WOOD буде використаний пізніше. 

 

Використання бібліотеки матеріалів 
 

Після створення нового матеріалу його можна зберегти в бібліотеці 

матеріалів і використати його при роботі над новим проектом. 

Збереження матеріалу в бібліотеці: 

1. Зробіть праве клацання на імені FLOOR_WOOD в Панелі 

матеріалів, а потім виберіть Save. З'явиться діалог Save As. 

2. Наберіть Floors.atr в кадрі імені файлу (File Name). Якщо 

потрібно перейдіть в теку Lightscape. 

3. Натискуйте Save. 
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На панелі попереджувального діалогу відповідайте Yes, щоб 

підтвердити створення нової бібліотеки матеріалів. 

Завантаження матеріалу з бібліотеки: 

1. Зробіть праве клацання в Панелі матеріалів, потім виберіть Load. 

Відкриється діалог Open file. 

2. Виберіть Gallery.atr в списку файлів (File Name). Якщо необхідно, 

змініть теку на Lightscape. 

3. Натисніть Open. Відкриється діалог вибору матеріалу (Available 

Materials). 

4. Натискуйте Select All для виділення всіх матеріалів. 

Натискуйте OK для завантаження матеріалів з бібліотеки. На панелі 

попереджувального діалогу відповідайте Yes, щоб підтвердити заміну всіх 

матеріалів. 

Вид стелі, стін і підлоги зміниться, оскільки відповідні матеріали 

були спеціально визначені і збережені в бібліотеці Gallery.atr, і під час 

завантаження вони замінили матеріали з відповідними іменами. 

 

Відображення текстур 
 

Після призначення матеріалів з текстурами поверхням можна 

включити їх демонстрацію у Графічному вікні. В справжній сцені текстури 

мають всі картини. 

Включення текстур: 

1. Головне меню -> Display -> Textures або натискайте клавішу 

Textures. Через деякий час текстури будуть завантажені в сцену. 

Завантаження відображається на смузі стану. 

2. Натискайте кнопку Textures знову, щоб погасити текстуру. 

Ви можете визначити, чи завантажена текстура по Панелі матеріалів. 

Кольоровий квадрат поряд з кожним матеріалом відображає колір 

матеріалу. Кольоровий символ текстури поряд з ім'ям матеріалу вказує, що 

текстура завантажена і відображена в Графічному вікні. Чорно-білий 

символ текстури вказує, що текстура була завантажена, але в даний час не 

відображена. Зелений вказує, що файл текстури, пов'язаний з матеріалом, 

не міг бути знайдений. Коли Ви змінюєте файл текстури, Ви повинні 

перезавантажити текстури, щоб модифікувати сцену. Щоб 

перезавантажити все текстури, що використовуються в сцені, виберіть 

Головне меню -> Display -> Reload Textures. Щоб перезавантажити 
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текстури тільки для відібраних матеріалів, клацніть правою кнопкою миші 

в Панелі матеріалів і виберіть Reload Texture. 
 

Робота з світильниками 

 

Світильниками в Lightscape є спеціальні блоки, що мають пов'язані з 

ними фотометричні параметри. При створенні світильника блок 

видаляється із списку панелі Blocks і розміщується на панелі Luminaires. 

Всі вставлені в сцену зразки блоків перетворяться в світильники. 

Світильник в Lightscape включає геометрію приладу, колір 

випромінювання і криву сили світла. Світильник створюється 

приєднанням до блоку фотометричних характеристик. 

Фотометричні характеристики світильників: 

Ви можете задати наступні характеристики світильників: ''Light 

Source Type", "Lamp Type", "Intensity Magnitude", "Intensity Distribution", 

"Photometric Web". 
 

Light Source Type (Тип світильника) 
 

Вибирається із розкриваючогося списку Source Type, який має 

наступні значення: 

Point Light (Точкове джерело) – наприклад, нитка розжарення в 

лампах розжарювання. 

Linear Light (Лінійне джерело) – наприклад, люмінесцентна лампа. 

Area Light (Поверхневе джерело) – наприклад, світильник з двома і 

більше люмінесцентними лампами з розсіювачем. 
 

 

Lamp Type (Тип лампи) 
 

Lightscape дозволяє вибрати наступні кольори випромінювання ламп 

із списку Lamp Color Specification, що розкривається: 
 

D65White Fluorescent Deluxe warm white Deluxe  cool white 

Warm white Cool white White fluorescent Daylight fluorescent 

Incandescent Xenon Halogen Metal halide 

Mercury Phosphor 

mercury 

High-pressure sodium Low-pressure sodium 
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Intensity Magnitude (Інтенсивність світла) 
 

Інтенсивність світла задається в полі Intensity Magnitude. Існують 

три способи її задання: 

Luminous Intensity (Сила Світла) – осьова сила світла світильника [кд]. 

Luminous flux (Світловий Потік) – повний світловий потік 

світильника [лм]. 

Illuminance at а Distance (Освітленість) – освітленість на осі 

світильника на деякій відстані від нього. 

 

Крива сила світла (КСС) 
 

КСС світильника в програмі може бути наступного типу: 

Isotropic (Ізотропна) – тільки для точкових джерел. 

Spot (Направлена) – задається двома кутовими полями: Beam angle 

(кут спаду сили світла удвічі) і Field angle (кут свічення). 

Diffuse (Дифузний) – тільки для поверхневих світильників. 

Photometric Web (Фотометрична сітка) – КСС задається 

двовимірною сіткою або у форматі IES (Illuminating Engineering Society 

North America), що представляють значення сили світла у вузлах 3D сітки. 

 

Photometric Web (Фотометрична сітка) 
 

КСС реальних світильників не відповідає моделям Spot, Isotropic або  

Diffuse. Форма відбивача, тип лінз, що використовуються, і тип лампи в 

комбінації створюють унікальний розподіл світла. КСС часто 

представляють у вигляді гоніометричних діаграм, які є плоскими кривими 

перетину КСС для декількох азимутних кутів. Фотометрична сітка – це ні 

що інше, як формат кривої сили світла, представленої у файлі з 

розширенням *.IES, в 3D виді. 

 

Націлювання прожекторів на картини: 
 

1. Вибір прожектора 

Головне меню -> Edit -> Selection -> Select або натискайте кнопку 

Select – ліва кнопка миші перемикається в режим Вибору (Select mode). 

Головне меню -> Edit -> Selection -> Luminaire або натискайте 

кнопку Luminaire – вибір тільки світильників. 

Зробіть ліве клацання по одному з прожекторів. 
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2. Головне меню -> Edit -> Transformation або праве клацання в 

будь-якому місці Графічного вікна, потім Transformation. З'являється 

панель діалогу Transformation. 

3. Виберіть ярлик Aim (Націлювання). 

4. Використовуйте функцію Pick (Вказати) для націлювання 

прожектора: 

Включіть Pick – ліва кнопка миші перемикається в режим Вказівки. 

Вкажіть лівим клацанням в центр рамки картини під вибраним 

світильником. 

Відключіть Pick. 

5. Виберіть наступний світильник для націлювання. Якщо після 

вибору другого світильника збережеться виділення першого, то 

включиться функція Accumulate Pick. Для її відключення натисніть кнопку 

Accumulate Pick. 

6. Включіть функцію Pick для активації режиму Вказівки мишею. 

7. Вкажіть лівим клацанням в центр рамки картини під вибраним 

світильником. 

8. Можна істотно знизити кількість рухів мишею, якщо 

використовувати гарячі клавіші. На цьому кроці використовуйте гарячі 

клавіші для тимчасового припинення режиму вказівки мишею (Pick) і 

активації режиму вибору (Select). 

• Тримайте натиснутою клавішу-1 для тимчасового включення 

режиму Select. При цьому кнопка Select на панелі інструментів повинна 

натиснута. 

• При натиснутій клавіші-1, виберіть інший світильник. 

• Відпустіть клавішу-1 і вкажіть точку націлювання прожектора. 

9. Повторюйте Крок - 8 поки всі шість прожекторів не буде 

направлено на свої картини. Під час вибору можна управляти зображенням 

для зручнішого вибору об'єктів, натискаючи гарячі клавіші управління 

виглядом, наприклад, О для Orbit. 

10. Натискайте OK на панелі діалогу Transformation після 

завершення націлювання всіх світильників. 

Головне меню -> View-> Display Original View – для повернення до 

початкового зображення. 

Головне меню -> Edit-> Selection -> Deselect All або натискайте 

клавішу Deselect All. 
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Порада: Ви можете перемістити панель Transformation, якщо вона 

загороджує Вам вигляд. Якщо після цього область за панеллю залишиться 

чорною, клацніть по заголовку Графічного вікна і натискайте F5 або 

Display -> Refresh для оновлення зображення. 

 

Збереження файлу 
 

На цьому етапі краще зберегти роботу. У програмі Lightscape 

операція Відновити (Undelete) дозволяє відновлювати більшість тільки що 

видалених з сцени об'єктів, якщо не була змінена база даних об'єктів. Для 

відновлення виберіть Головне меню -> Edit -> Undelete або натисніть 

клавішу Undelete. В загальному випадку, використовуйте операції Save або 

Save As, щоб мати точку повернення. 

1.    File -> Save As – діалог Save As. 

2.  Наберіть Test_gallery.lp в кадрі імені файлу (File Name) і натисніть 

Save. 
 

Розрахунок сцени методом випромінюваності 
 

Ви повністю завершили етап підготовки сцени і можете переходити 

до розрахунку сцени методом випромінюваності після ініціалізації сцени. 

Етап підготовки сцени до рішення: 

1. Натисніть клавішу Solid. 

2. Головне меню -> Process-> Initiate або натисніть клавішу Initiate. 

3. Якщо Ви внесли якісь зміни в сцену після збереження файлу, 

з'явиться відповідний запит. Натискайте No. 

Після ініціалізації зображення сцени в Графічному вікні стає темним, 

оскільки далі зображення сцени змінюватиметься, відповідно до розподілу 

світлової енергії методом випромінюваності, і в початковий момент часу 

енергія від світильників ще не розподілялася. Ця стадія називається 

Станом нульової енергії (Zero Energy State) або Нульовою ітерацією. 

Відзначимо, що в смузі заголовка Графічного вікна розширення 

файлу змінилося на *.ls, вказуючи на те, що сцена тепер зберігатиметься у 

форматі Solution (рішення). 
 

Установка параметрів рішення: 
 

Головне меню -> Process -> Parameters – з'явиться діалог параметрів 

процесу (Process Parameters). Числові значення різних параметрів панелі 

діалогу визначають якість і тривалість розрахунку. Кожна величина може 
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бути встановлена самостійно, проте можна скористатися Майстром 

(Wizard). 

Для розрахунку розподілу освітленості із заданою точністю 

Lightscape автоматично розбиває поверхню на менші частини, названі 

елементами (elements). Набір елементів і вершин поверхні називається 

сіткою. Програма починає розрахунок з грубої сітки, розбиваючи її 

автоматично за наявності значного градієнта уздовж елементу. Цей процес 

носить назву адаптивного розбиття сітки, а його параметри визначаються 

значеннями змінних, встановлюваних в полях Receiver Group і Source 

Group. Використовуючи ці параметри, можна оптимізувати час, точність 

обчислень, а також оперативну пам'ять, що так само використовується 

програмою. 

Замість того щоб рівномірно розбивати всю сітку на дрібніші вузли, 

програма робить дрібніший розподіл в місцях з великим градієнтом 

освітленості, наприклад, на межі світла і тіні, і залишає великі елементи 

там, де освітленість незмінна. Такий підхід дозволяє раціонально 

використовувати ресурси комп'ютера. 

Рішення починається з обчислення освітленості у вершинах 

початкової сітки від джерел світла. Потім для кожного елементу сітки 

програма обчислює контраст освітленості (відношення різниці 

максимальної і мінімальної освітленості до середньої) уздовж елементу. 

Низький контраст (близько 0) відповідає однорідно освітленій поверхні, 

високий контраст (близький до 1) говорить про необхідність додаткового 

розбиття цього елементу сітки. Контроль над розбиттям здійснюється 

параметром Subdivision Contrast Threshold (Пороговий контраст розбиття): 

якщо контраст більше порогу, програма розбиває елемент на 4 подібних 

менших елементів. Для кожного нового елементу знову визначається 

контраст розподілу освітленості і знов проводиться розбиття його при 

перевищенні порогу. Тим самим будується адаптивна мережа, що 

повторює розподіл освітленості. 
 

Параметри приймача (Receiver Group) 
 

Maximum Mesh Spacing – встановлює початковий максимальний 

розмір елементів сітки. 

Minimum Mesh Spacing – встановлює найменший можливий розмір 

ребер елементів сітки. 

Subdivision Contrast Threshold – визначає пороговий контраст. 
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Параметри джерела (Source Group) 
 

Елементи поверхні розбиваються не тільки на прийом 

випромінювання, але і при власному випромінюванні (відбитті). Якщо 

елемент належить поверхні джерела, то його розбиття контролюється 

параметрами Direct Source, а при відбитті – Indirect Source: 

Source Subdivision Accuracy Parameters – визначає найбільшу 

кількість елементів випромінювання. 

Direct Source Minimum – встановлює мінімальний розмір елементу 

сітки джерела. 

Indirect Source Minimum – встановлює мінімальний розмір елементу 

сітки при перевідбиттях. 

1. Натискайте клавішу Майстра (Wizard) для виклику Майстра 

параметрів розрахунку. 

2. Виберіть «3» для рівня якості зображення (середнє) і натискайте 

Next для переходу до наступного кроку роботи Майстра. 

3. Наголосіть на No, що означає, що денне світло не включається в 

модель, потім Next. 

4. Натискайте Finish для оновлення параметрів розрахунку. Зверніть 

увагу на зміни параметрів, що відбулися. 

5. Натискайте OK для закриття Панелі діалогу визначення 

параметрів розрахунку. 

 

Процес рішення: 
 

При розрахунку Lightscape використовує так званий метод 

поліпшеної рекурсивної випромінюваності (radiosity). На кожній ітерації 

програма вибирає найяскравіше джерело світла і обчислює внесок у всі 

поверхні сцени. Наприклад, якщо Ваша модель включає денне освітлення, 

то сонячне світло береться в першій ітерації. 

Спочатку розрахунок починається з світильників, а далі Lightscape 

розраховує перевідбиття між поверхнями. На кожній ітерації програма 

вибирає найяскравішу поверхню і обчислює внесок відбитого на ній 

випромінювання на всю решту поверхонь. Таким чином, рішення методом 

випромінюваності уточнюється на кожній ітерації. 

У принципі, уточнення продовжується, поки не буде враховано всі 

можливі перевідбиття, проте з досвіду в кінці обчислень візуальні 

відмінності між послідовними ітераціями стають незначними. 
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Запуск процесу рішення методом випромінюваності: 
 

1. Головне меню -> Process -> Go або натисніть клавішу Go, після 

чого Lightscape проводить обчислення світла, що перерозподіляється, по 

сцені. Це може зайняти від декількох хвилин до декількох годин. Час 

процесу залежить від кількості поверхонь в сцені, світильників, параметрів 

сітки і ресурсів комп'ютера. 

2. Для вибраної моделі допустимо близько 50 ітерацій, які 

розподілять приблизно 80% світлової енергії світильників. 

3. Головне меню -> Process -> Stop або натисніть клавішу Stop. 

Процес розрахунку зупиниться після завершення чергової ітерації, 

що може зайняти декілька секунд. Повідомлення ―Preparing to stop 

processing‖ з'явиться на смузі стану. Після завершення обчислень там же 

з'являється ―Processing Stopped‖. 
 

Порада: Зображення сцени в Графічному вікні перемальовується 

після виконання кожної ітерації, що дозволяє глибше зрозуміти процес 

виконання методу випромінюваності (radiosity). Кожного разу на 

перемальовування процес обчислень зупиняється. При обчисленні 

складних проектів слід запускати пакетний файл lsrad для отримання 

швидших результатів. 
 

Аналіз основної сітки методу випромінюваності 
 

1. Натисніть кнопку Outlined. Lightscape здійснює адаптивне 

розбиття всіх поверхонь сцени на осередки сітки, яка підлаштовується під 

розподіл випромінювання на ній. Грані з малим градієнтом освітленості 

розбиваються на рідкісні осередки з великими вимірюваннями, а при 

великому градієнті освітленості на поверхні, таких як на межі світло тінь, 

сітка щільніша. Ключ контролю процесом розбиття визначається 

встановленими параметрами розрахунку. Ці параметри визначають 

густину сітки і точність розрахунку. 

2. Натисніть кнопку Solid для повернення в режим безперервного 

тонування (Solid). Регулювання зображення, використовуючи контроль 

Рівня подробиць (Level Detail): одна з найважливіших особливостей 

програми Lightscape – можливість інтерактивного переміщення виду сцени 

і докладного дослідження візуалізованої сцени. 

3. Натисніть кнопку Orbit і зробіть орбітальні перетворення сцени.  

Перетворення проводяться дуже швидко, оскільки Lightscape 

зберігає дифузний розподіл світла як невід'ємну частину тривимірних 
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поверхонь в моделі у формі тривимірної структури сітки методу 

випромінюваності. Після розрахунку програма тільки апроксимує 

обчислені значення кольорів, що зберігаються у вузлах сітки, відповідно 

до вибраного ракурсу. Ця проста і швидка техніка, звана тонуванням 

Gouraud, підтримується OpenGL. Один з шляхів збільшити швидкість 

відображення сцени на екрані є використання управління рівнем 

подробиць. 

1. Головне меню -> File -> Properties. 

2. Виберіть закладку Display Interactivity. 

3. Встановіть середній рівень деталей: 

    Встановіть повзунок Level Detail приблизно на «25» натисніть Apply. 

4. Проаналізуйте швидкість орбітальних перетворень сцени. 

5. Встановіть низький рівень деталей: 

     Встановіть повзунок Level Detail на «1», натисніть Apply. 

6. Проаналізуйте швидкість орбітальних перетворень сцени тепер. 

7. Після завершення експериментів встановіть Level Detail рівним 

«100» і натисніть OK. 

8. Головне меню -> View -> Display Original View. 
 

 

Привласнення матеріалів 
 

Важливою властивістю Lightscape є можливість зробити після 

початку обчислень зміни матеріалів поверхні. Це дозволяє користувачу 

швидко протестувати різні варіанти обробки сцени і розміщення 

світильників. 

Заміна килимового покриття на дерев'яну підлогу: 

1. Для відображення текстур натисніть клавішу Textures. 

2. Для привласнення матеріалу лаковане дерево перетягніть 

FLOOR_WOOD з Панелі матеріалів на поверхню підлоги і відпустіть 

кнопку миші після того, як ребра поверхні виділяться блакитними і 

жовтими пунктирними лініями. 

Порада: Існує й інший шлях привласнення матеріалів. Після вибору 

однієї або декількох поверхонь зробіть праве клацання в Графічному вікні 

і виберіть Assign Material (Прісвіть матеріал). В панелі діалогу Assign 

Material виберіть із списку матеріал по його назві і натискайте OK. 

Відзначимо, що таким прийомом привласнюється матеріал декільком 

поверхням. 
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Зверніть увагу, що колір підлоги зміниться одразу ж після 

привласнення йому матеріалу, але колір перевідбитого на стіни і стелю 

світла залишиться незмінним. Для оновлення перевідбитої компоненти, 

необхідно продовжити процес обчислень. 

Продовження обчислень на декілька ітерацій: 

1. Натискайте клавішу Go. 

2. Після декількох ітерацій натисніть Stop і зупиніть процес 

обчислень. Наголосіть на змінах кольору в сцені. 

Тільки після декількох ітерацій Ви зможете помітити ефект заміни 

матеріалу на суміжних поверхнях. Колір стін і стелі змінився значно. Це 

демонструє важливий ефект "перетікання" кольору: різні матеріали і 

світильники можуть впливати на естетичне сприйняття приміщення і 

простори. 

Здатність моделювати перетікання кольору – одна з ключових 

переваг, які Lightscape здійснює понад звичні технології візуалізації. Інша 

перевага полягає в тому, що Ви можете виконати аналіз розподілу світла 

по сцені, тому що світильники можуть бути визначені з використанням 

реальних фотометричних значень (включаючи технічні дані від 

виробників). 
 

 

Аналіз розподілу світла в приміщенні: 
 

1. Головне меню -> Light -> Analysis – з'явиться діалог Lighting 

Analysis (Аналізу світлорозподілу). 

2. Виберіть закладку Statistics. Тепер ви можете використати курсор 

миші як "віртуальний люксметр" в сцені на екрані комп'ютера. 

3. Перевірте освітленість на поверхні картин: 

Вкажіть мишею точки біля середини картин: значення освітленості 

виводяться в панелі діалогу. 

Перевірте освітленість в найяскравіших точках галереї: освітленість 

картин в галереї не може перевищувати 20 футкандел (footcandles).  

4. Виберіть закладку Display. 

5. Виберіть Color зі списку в закладці Display. 

6. Введіть значення «75» в поле Max і натисніть Apply. Тепер сцена 

відображається в псевдокольорах для візуалізації світлорозподілу по сцені. 

Змінюйте вид сцени для повної оцінки освітлення галереї. 

7. Для виходу з режиму натискайте Cancel. 

8. Головне меню -> View -> Display Original View. 



 145 

Робота зі світильниками 
 

Точно так, як Ви змінювали властивості матеріалів поверхонь сцени, 

можна провести зміну характеристик світильників. 

Порада: Ви не можете змінити підвіску і націлювання світильників в 

режимі Обчислень (Solution model). Зміна геометрії можлива тільки в 

режимі Підготовки (Preparation model). 

Зміна параметрів одного з світильників: 

1. Натисніть кнопку Select, а потім кнопку Luminaire. 

2. Вкажіть точку на або біля одного з прожекторів, націлених на 

картину – вибраний світильник виділиться кольором. 

3. Зробіть праве клацання в області Графічного вікна і виберіть 

Photometrics (Фотометрія) – з'явиться панель діалогу Luminaire Instance 

Properties. 

4. Змініть фотометричні параметри світильника: встановіть 

Насиченість (S, Saturation) кольорового фільтру на «0.50», Тон (H, Hue) і 

Величину (V, Value) на «0»  і «1.00»  відповідно. 

У групі Сила світла (Intensity) встановіть повзунок Field Angle 

(Кутове поле) на «120», а Beam Angle (Кут жмутка) на «40».  

Форма світлової плями прожектора змінилася. 

Порада: Важливо спочатку встановити Field angle, а потім Beam 

angle тому, що Beam angle не може перевищувати значення Field angle. 

1. Натискайте OK і підтвердіть зміни. 

2. Натискайте клавішу Deselect All. 
 

Продовження обчислень на декілька ітерацій: 
 

Ви повинні виконати моделювання для ще декількох ітерацій, щоб 

дозволити Lightscape обробити нові властивості зміненого світильника. 

Система спочатку віднімає початкову світлову енергію, а потім додає 

перевизначену енергію світла назад в сцену. 

1. Натисніть клавішу Go. 

2. Після декількох ітерацій натисніть Stop і зупиніть процес 

обчислень. Світильник, енергію якого програма перерозподіляла, буде 

виділений червоним кольором. 

 

Створення зображення 
 

Візуалізація (Rendering) є перетворенням тривимірної сцени на 

двовимірне зображення.  



 146 

Lightscape дозволяє виконати цей процес двома способами: 

виконати візуалізацію сцени за результатами розрахунків методом 

випромінюваності; 

додати дзеркальне відбиття і пропускання методом трасування 

проміння. 

 

Створення зображення методом випромінюваності 
 

Якщо Вас задовольняє установка матеріалів і світильників в сцені, а 

так само якість одержаного рішення методом випромінюваності, то ви 

можете зберегти зображення, використовуючи функції OpenGL. Звичайно 

OpenGL використовується для інтерактивного виведення на екран 

візуалізації сцени методом випромінюваності (radiosity). Використовуючи 

OpenGL, Ви можете візуалізувати сцени тільки з дифузно розсіюючими 

поверхнями. Ви не можете моделювати дзеркальне відбиття і направлене 

пропускання. Якщо Вас влаштовують перераховані обмеження, то OpenGL 

є найшвидшим способом збереження і відтворення візуалізації тривимірної 

сцени. Це стає особливо важливим, якщо Ви зберігаєте декілька 

зображень, як, наприклад, при анімації сцени. 

 

Створення зображення сцени тільки з дифузними поверхнями: 
 

1. Головне меню -> View -> Display Original View. 

2. Якщо це необхідно, натисніть клавішу Textures для підключення 

текстур. 

3. Головне меню -> File -> Render – з'являється панель діалогу 

Візуалізації (Rendering). 

4. У групі кінецвий файл (Output File) виберіть JPEG (*.jpg) із списку 

Format. 

5. Наберіть Test_Radiosity.jpg в полі Name і натискуйте OK. 

6. Lightscape зробить знімок із зображення на екрані і збереже його 

на диску. Повідомлення Rendering progress (Йде процес візуалізації) 

з'явиться в смузі стану. 

 

Порада: Ви можете поліпшити зображення сцени, створене 

Lightscape, використовуючи antialiasing для усунення зубчатості. Чим 

вище заданий рівень Antialiasing, тим більше час на створення зображення. 
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Створення зображення за допомогою трасування проміння 
 

Для створення зображення високої якості використовуйте 

трасування проміння, що дозволяє додати в зображення дзеркальні 

відвідбиття й інші світлові ефекти. Процес трасування проміння, що 

використовується в Lightscape, швидший за традиційне трасування 

проміння, тому що трасувальник променя не повинен обчислювати пряме 

освітлення: воно вже розраховано методом випромінюваності. Для деяких 

джерел освітлення (типу прожекторів і сонячного світла) можна дослідити 

слід прямого світла і одержати якісніші тіні. 

Визначення світильників, пряме світло яких буде включено в 

трасування проміння: 

1. Натискайте кнопку Select, а потім клавішу Luminaire. 

2. Виберіть один з прожекторів, направлених на картину. Він 

виділиться кольором. 

3. Зробіть праве клацання в Графічному вікні і виберіть Luminaire 

Processing – з‘явиться діалог Luminaire Processing. 

4. Наголосіть на Ray Trace Direct Illumination і клацніть OK. На 

інших опціях вже наголошено. 

 

Параметри створення зображення при використанні трасування 

проміння: 
 

Lightscape створює зображення сцени для будь-якої роздільності і 

стандартного формату файлів. Основними опціями процесу є: 

Format Type – тип формату файлу. 

Resolution (size) – роздільність (розмір) зображення вибирається із 

списку Resolution роздільностей, що розкривається, або введенням значень 

в поля Width (Ширина) і Height (Висота). 

Antialiasing – рівень усунення сходинності і зубчатості. 

Ray tracing – трасування проміння в Lightscape використовується для 

включення ефектів дзеркального відбиття в рішення, дозволяє включити 

пропускання світла і точніше одержати первинну тінь від джерел. 

Ray Trace Direct Shadows – з цією опцією перерозраховуються пряме 

світло від Сонця і вибраних світильників, що дозволяє усунути артифакти 

типа "нерівностей". 

Ray Bounces – встановлює кількість відбиттів і пропускань променя 

при трасуванні. 
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1. Головне меню -> File -> Render – з'явиться діалог Rendering. 

2. Встановіть опцію Ray Tracing: 

Наголосіть на Ray Tracing. 

Наголосіть на Ray Trace Direct Illumination – трасування прямого 

світла буде виконано для на наголошених світильниках. 

3. У групі Output File наберіть в полі імені файлу Test_Raytracing.jpg: 

якщо поле Name залишити чистим, то програма виведе зображення на 

екран, але не збереже його на диску. 

4. Виберіть JPEG (*.jpg) із списку Format. 

5. Натисніть OK і підтвердіть додаткові процеси перед трасуванням 

проміння. 

Lightscape виконає ітерації для кожного світильника, встановленого 

для трасування проміння (в нашому випадку, тільки один): видалить 

внесок прямого проміння по поверхнях сцени, після чого проведе 

трасування проміння. Незабаром Ви побачите дзеркальні відбиття від 

поверхні підлоги, які не були видимі в дифузній моделі методу 

випромінюваності або представленні зображення в OpenGL. Ви також 

побачите результати процедурної карти інтенсивності, яка дає ефект 

«старий алебастр» на червоній стіні в ніші (западина в стіні). 

Ви можете відзначити, що деякі з поверхонь здаються яскравішими, 

ніж вони здавалися в уявленні OpenGL. Це особливо вірно для поверхонь з 

картою текстур і самосвітних поверхонь. Ця відмінність пов'язана з тим, 

що трасувальник проміння Lightscape обробляє взаємодію світла з такими 

поверхнями точнішим шляхом, ніж це робить OpenGL. 

Ви можете легко скоректувати яскравість будь-якого матеріалу перед 

трасуванням проміння, регулюючи V слайдер (Value) на закладці Color 

панелі діалогу Material Properties. Якщо матеріал має текстуру, коректуйте 

повзунок Brightness на панелі Texture. 

Трасування області сцени: 

Для швидкого тестування матеріалу в сцені перед тривалим 

трасуванням високого дозволу Ви можете використовувати операцію 

трасування області (Ray Trace Area), яка виконає трасування проміння для 

виділеної області сцени на екрані, що дозволить визначити вид поверхні і 

скоректувати його властивості. 

1. Для відновлення зображення виберіть Головне меню ->  

Display-> Refresh або натискайте F5. 
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2. Оскільки один з світильників встановлений в режимі Ray Trace 

Direct Illumination, то цю ж опцію треба включити і в операції Ray Trace 

Area: 

Головне меню -> Display -> Ray Trace Area Options – з'явиться діалог 

Ray Trace Area Options. 

Наголосіть на Ray Trace Direct Illumination і натискайте OK. 

3. Головне меню -> Display -> Ray Trace Area або натискуйте Ray 

Trace Area, що переведе ліву кнопку миші в режим спеціального 

виділення, яке використовується в Ray Trace Area. 

4. У Графічному вікні з натиснутою лівою кнопкою (буксирування) 

виділіть прямокутну область трасування: наприклад, намалюйте 

прямокутник навкруги картини, на яку націлений світильник з опцією 

Trace Direct Illumination. 

5. Після того, як Ви відпустите ліву кнопку миші, з'явиться 

попередження. Натисніть OK і буде виконано трасування проміння. 
 

Порада: Попередження з'являється тільки при установці опції Ray 

Trace Direct Illumination. 

 

Вихід з програми Lightscape 
 

Команда Exit в головному меню File або Alt + F4. 

У випадку якщо Ваш проект ще не був збережений, програма запитає 

у Вас про збереження. 

 Для самоконтролю рекомендується користуватися файлами 

«Test_gallery.lp» і «Test_gallery.ls», що знаходяться в архіві 

LessonLightscape.zip.  

 

 

3.5 Основи моделювання освітлення в програмі DIALux 
 

Незаперечною перевагою програми DIALux є російськомовний 

інтерфейс, який значною мірою допомагає користувачу працювати з 

програмою без знань іноземної мови. 

В основі інтерфейсу програми лежить розділення екрану на декілька 

функціональних частин: 

У верхній частині – головне меню і лінійка інструментів швидкого 

доступу до команд. 
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Рис. 3.5 

 

Зліва Менеджер проекту – деревовидний список всіх елементів 

проекту із закладками до баз даних елементів проекту: спортивні поля, 

текстури, світильники, результати розрахунків. 
 

 
 

Рис. 3.6 

 

Зверху панелі Менеджера проекту розташовується вікно Інспектора 

властивостей виділених елементів проекту. 
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Рис. 3.7 

 

У центрі CAD – вікно, що представляє варіант класичного вікна 

графічного редактора векторних двовимірних і тривимірних зображень; 

різні види сцени встановлюються клавішею на Лінійці інструментів або в 

головному меню Вигляд і розташовуються на різних закладках зверху 

вікна. 

 
 

Рис. 3.8 
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Справа панель Провідника проектом – швидкий доступ до основних 

етапів створення і розрахунку ОУ. 

 

  
 

Рис. 3.9 

 

Програма DIALux, починаючи з версії 4.6, поповнилася модулями, 

що полегшують проектування освітлення для спортивних об'єктів. 

Майданчики можна розміщувати як в приміщеннях, так і зовні. 

Конструкція розрахункових сіток об'єктів, що автоматично додаються, 

відповідає вимогам згаданого нормативного документа, що стосується 

освітлення спортивних споруд. В «Провідник», який стандартно 

з'являється в правій частині вікна CAD, додана додаткова вкладка, 

присвячена проектуванню спортивних об'єктів. Виконуючи дії у вказаній 

послідовності, ми не пропустимо жодного важливого елементу проекту. 

Щоб представити можливості програми, як приклад буде 

використаний проект одного із спортивних комплексів «Орля 2012». 

1. Подвійне клацання для відкриття групи програм DIALux з меню 

Пуск -> Програми і подвійне клацання для запуску програми DIALux по її 

значку. 

2. При завантаженні програми Ви побачите Панель запрошення в 

програму. 

3. По закінченню завантаження в програмі DIALux автоматично 

відкривається панель Асистента проектів освітлення.  
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4. У стартовому діалозі необхідно вибрати Новий проект для 

зовнішньої сцени (рисунок 3.10). 

 
 

Рис. 3.10 – Початкове діалогове вікно 
 

 

Рис. 3.11 – Вкладка Провідника «Освітлення спортивних об'єктів» 
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5. Використовуючи шаблони, запропоновані розробниками 

програми, перейдемо до відповідної вкладки «Провідника» — «Освітлення 

спортивних об'єктів», де представлені всі етапи планування освітлення 

(рисунок 3.11). 

Оскільки ми вже створили сцену, а наш проект не містить 

архітектурної бази, перейдемо до дії «Ввести спортспоруду». Клацнувши 

на кнопці «Ввести поле світильників», ми побачимо в лівій частині вікна 

CAD перелік доступних спортивних арен і елементів, пов'язаних з 

освітленням спортивних об'єктів. В розпорядження проектувальника 

надаються «робочі області» найпопулярніших спортивних дисциплін. 

Можна вибрати: загальний спортмайданчик, який можна використовувати 

для дисциплін, що не увійшли до переліку, футбольне поле, поле для 

гандболу, баскетболу, волейболу, великого тенісу, бадмінтону і бігову 

доріжку. 
 

 
 

Рис. 3.12 – Вікно вибору виду спорту, для якого призначена споруда 

 

Користуючись вказівкою, розміщеною над меню, поле можна ввести 

в проект методом «перетягнути і відпустити». Інша можливість – клацнути 

на конкретній дисципліні, а потім в «Менеджері проекту» визначити 

величину об'єкту і натискувати кнопку «Вставити». 
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Рис. 3.13 – Визначення величини  споруди в «Менеджері проекту» 

  

Слід врахувати, що норма РN-EN 12193 визначає ігрове поле 

дисципліни як «Головне ігрове поле» (РА). Найчастіше цей той простір, в 

якому ведеться гра, обмежений лініями, до якого відносяться всі вимоги, і 

«Загальне ігрове поле», тобто прилеглий простір, наприклад поле ауту у 

футболі, для яких встановлені вимоги, що становлять 75% показників, 

передбачених для РА.  

У відповідні поля «Менеджера проекту» внесемо показники, 

закладені в програмі «Орля-2012».  

Після внесення футбольного поля відповідно до запропонованих 

розмірів, ми побачимо, що загальна поверхня має правильні розміри, тоді 

як елементи самого футбольного майданчика виходять за її межі. Мабуть, 

програмісти компанії DIAL не припускали, що хтось схоче проектувати 

такі маленькі футбольні майданчики. З одного боку, можна визнати це 

помилкою.  

Але, з другого боку, враховуючи необхідність збереження 

характерних розмірів, які повинні бути дотримані, наприклад лінія 3-

очкових кидків в баскетболі або відстань одинадцятиметрового удару від 

воріт, можна визнати, що такі обмеження необхідні. Залишивши осторонь 

міркування естетики, ввівши майданчик в проект, ми одержимо готове 

розрахункове поле з певною, відповідно до норми розрахунковою сіткою.  
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Для розрахунку всіх нормативних показників необхідно ввести GP-

спостерігачів (потужності засліплення). Для цього в меню «Розрахунковий 

растр (РА)» виберемо опцію «Створити GP-спостерігача» (рисунок 3.14).   

 

 
 

Рис. 3.14 – Створення GP-спостерігача 

 

В результаті цієї операції в кожну розрахункову точку буде 

установлений GP-спостерігач. Повторимо описані дії для баскетбольного і 

волейбольного майданчиків.  

Результатом другого кроку, після внесення декількох косметичних 

поправок для поліпшення презентації, стане представлена на рисунок 3.15 

«Зовнішня сцена». 
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Рис. 3.15 – Зовнішня сцена баскетбольного і волейбольного майданчиків 

 

6. Підготувавши об'єкт освітлення, необхідно вибрати тип 

світильника. Введення освітлювальних приладів в проект вже 

неодноразово описувалося в наших статтях. Цього разу виберемо 

відповідний для освітлення спортивних об'єктів асиметричний 

металогалогенний прожектор заливаючого світла Alum потужністю 400 

Вт. Виготовлений під маркою Brilum світильник має прекрасні 

світлотехнічні параметри і відрізняється високою якістю виконання. 

Ступінь захисту IP 65 гарантує стійкість світильника до атмосферних дій. 

 

 
 

Рис. 3.16 – Вибір світлового приладу 
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7. Найважливіший етап підготовки проекту, що вимагає знань, праці 

і часу – це розміщення світильників і відповідна орієнтація світлового 

жмутка.  

Програма DIALux 4.6 має ряд функцій, які значно полегшують і 

прискорюють цей етап роботи. Серед них слід зазначити систему 

розміщення світильників. Раніше проектувальнику доводилося займатися 

кожним світильником окремо. Тепер, завдяки функції «Розташування 

заливаючого світла», можна об'єднати декількох симетричних по 

відношенню один до одного точок. Це дозволяє перевірити різні 

можливості розташування світильників, використовуючи вектор 

розташування одного з них.  

Вибравши відповідну опцію в «Менеджері проекту», слід задати 

світильник, який ми хочемо використати, потім задати точку установки 

світильників, точку симетрії освітлення і кількість світильників в точці. В 

нашому випадку почнемо з двох світильників, розташованих по кутах 

футбольного поля, при цьому точкою симетрії буде центр поля. 

 

 

 

Рис. 3.17 – Розташування світильників 

 



 159 

Розміщення двох світильників точно в одному місці є певним 

спрощенням, проте, враховуючи відносно невеликі розміри світильника і 

велику відстань до освітлюваної поверхні, ми не одержимо значної 

помилки в розрахунках. Додатковий параметр – висота монтажу – в 

нашому випадку – 9 м.  

При введенні світильника в проект необхідно задати оборот 

світильника щодо центру оптичної системи, тобто визначити, які площини 

кривої розподілу сили світла відповідатимуть вектору напряму. Цей крок 

необхідний, оскільки відсутня єдина система фотометрування 

світильників. Кожний виробник світильників сам вирішує, яку  

площину С або G вибрати як нуль.  

Наш світильник повинен бути встановлений згідно С0 і G0. 

«Схопивши» стрілку вектора ми можемо повертати світильник в будь-

якому напрямі, указуючи центр освітлюваного простору. Головною межею 

запропонованої системи розміщення світильників  є те, що при зміні 

напряму світла головного світильника всі вторинні, зв'язані з ним 

світильники також змінюють свою орієнтацію. 

Ще одна корисна функція – виконання розрахунків вимірювальної 

сітки в реальному часі. Ця функція завжди активна, нам залишається 

тільки вибрати спосіб висновку розрахунків.  

Для цього в меню «Розрахунковий растр (РА)» (рисунок 3.18) 

виберемо «Опції відображення», потім позначимо позиції, що цікавлять 

нас, – «Показати значення» і «Показати фіктивні кольори». Щоб повною 

мірою використовувати ці опції, виберемо в цьому ж меню «Обробити 

допоміжні лінії/фіктивні кольори».  

Тепер визначимо в «Менеджері проекту», яким чином будуть 

представлені зміни. Розробники пропонують нам схему «Спорт». Завдяки 

описаним вище інструментам ми можемо швидко задати кількість і напрям 

світильників. Розрахунки проводяться в реальному часі, що дозволяє не 

витрачати час на точні розрахунки після кожної зміни напряму 

світильників. 

На рисунку 3.19 наведений варіант розміщення. Виділені вектори 

відносяться до первинних світильників, переміщення яких слугуватиме 

основою для аналізу. Решта ліній – результат симетричного розташування 

світильників. 
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Рис. 3.18 – Вікно розрахунку в реальному часі 
 

 
 

Рис. 3.19 – Хід променів при вибраному розміщенні СП 
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8. Модуль освітлення спортивних споруд передбачає можливість 

визначення місця установки освітлювальних опор. Сама опора не показана у 

вигляді тривимірного тіла в «Зовнішній сцені», але її присутність значно 

полегшує презентацію результатів. На відповідній сторінці на висновку – 

Щоглові світильники (Резюме)» – буде показана кожна опора з розміщеними 

на ній світильниками. Додатково буде вказаний спосіб монтажу світильника 

на опорі. Результати розрахунку освітлення наведені на рисунку 3.20. 
 

 
 

Рис. 3.20 – Результати розрахунку в програмі DIALux 

 

Проектування системи освітлення футбольного поля в програмі 

DIALux 
 

1. Початок роботи. В стартовому вікні програми виберемо «Новий 

проект для зовнішньої сцени». Цей етап вже знайомий нам по попередніх 

частинах. 

2. Використовуючи шаблони, запропоновані розробниками 

програми, перейдемо до відповідної вкладки «Провідника» – «Освітлення 

спортивних об'єктів», де представлені всі етапи планування освітлення. 

3. Надалі у лівому нижньому вікні, у вкладниці об'єкти обираємо 

папку спортивні споруди, там ми бачимо перелік необхідних елементів, які 

потрібні для різних видів спортивних змагань, серед них обираємо 
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футбольне поле і лівою кнопкою маніпулятора ―миші‖ перетягуємо його у 

вікно зовнішньої сцени. 

  

Рис. 3.21 – Внесення до проекту футбольного поля 
 

4. Для визначення геометричних параметрів поля у менеджері 

проекту знаходимо вкладинку геометрія. Там ми можемо редагувати 

початкову позицію об'єкта, його розмір та обертання відповідно по осям x, 

y та z. Нам потрібно у графі розмір ввести довжину, ширину та висоту 

футбольного поля – L, B та H відповідно (рисунок 3.22). 
 

 
 

Рис. 3.22 – Редагування футбольного поля 

 



 163 

5. Для того, щоб обрати текстуру поверхні поля знаходимо у 

вкладинці кольори (рисунок 3.23), яка розташована після вкладники 

об'єкти, папку текстура -> підлоги -> інше далі програма надає 

можливість вибрати одну з таких текстур, як: асфальт, трава, гравій, пісок, 

галька. У нашому випадку треба обрати траву, тому лівою кнопкою 

маніпулятора ―миші‖ переносимо її  на наше футбольне поле. 
 

 
 

Рис. 3.23 – Нанесення текстури на футбольне поле 

 

6. Наступним кроком є внесення до проекту щогл, але спочатку ми 

обираємо позицію щогли. Для цього, як було представлено у пункті 2, 

заходимо об'єкти: спортивні споруди. Першою у списку є позиція щогли, 

тому лівою кнопкою маніпулятора ―миші‖ ми обираємо її і переносимо у 

вікно зовнішньої сцени, до нашого футбольного поля (рисунок 3.24).  

Для того, щоб відредагувати  позицію щогли, відповідно до завдання, 

ми знову заходимо до вкладки геометрія і у графі початкова позиція 

об'єкта вводимо позиції по осям x та y, як вказано у завданні. 

7. Надалі нам потрібно ввести до проекту самі щогли, так як вони не 

представлені у проекті, ми будемо створювати їх самі за допомогою 

стандартних елементів (рисунок 3.25). Для цього нам потрібно знову 

повернутися до вкладки об'єкти: стандартні елементи, там ми 

знаходимо такі прості геометричні фігури, як квадр, призма, 

горизонтальний та вертикальний циліндр, конус, екструдер та скляна 

пластина. Ми лівою кнопкою маніпулятора ―миші‖ вводимо до проекту 
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конус або вертикальний циліндр і редагуємо його до таких параметрів, як 

нам потрібно, за допомогою вкладки геометрія, як було представлено 

раніше у пунктах 4 та 6. 

 

 
 

Рис. 3.24 – Внесення до проекту позицій щогл та їх редагування 

 

  
 

Рис. 3.25 – Створення щогли (внесення до проекту конусу) 

 

Так як сам конус або циліндр ще не являє собою щоглу, надалі ми 

обираємо квадр і також редагуємо його, як показано на рисунку 3.26. 
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Рис. 3.26 – Редагування щогли 

 

8. Надалі нам потрібно розмістити щогли по периметру поля так, як 

вказано у завданні, тому спочатку ми копіюємо щоглу уздовж однієї лінії, як 

показано на рисунку 3.27. 

 

 
 

Рис. 3.27 – Копіювання щогли 
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Потім відповідно розміщуємо щогли на другій стороні футбольного 

поля (рисунок 3.28). 

 

 

 

Рис. 3.28 – Копіювання щогл відносно осі поля 

 

 
 

Рис. 3.29 – Футбольне поле зі щоглами 

 

9. Наступним кроком є вибір та розташування світлових приладів (СП). 

Доступ до баз даних світильників здійснюється вибором закладки 

Вибір світильників в Менеджері проекту. Світильники так само 

розташовуються ієрархічним списком: Власний банк даних, Каталоги 
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DIALux, Online каталоги, Використані раніше світильники. Вибір бази 

даних проводиться подвійним клацанням, інтерфейс знаходження і вибір 

конкретного світильника залежить від конкретного виробника. 

Online каталоги при підключенні до мережі Інтернет дозволяють 

користувачу проглянути каталог світильників і одержати його опис 

безпосередньо з сайту виробника. Для використання Каталоги DIALux 

конкретної фірми вони повинні бути встановлені як PlugIn.  
 

 
 

Рис. 3.30 
 

Власний банк даних дозволяє зберігати світильники різних 

виробників, що часто використовуються в проектах, і так само імпортувати 

(кнопка Import) світильники з описом (КСС) у файлах текстового формату 

*.IES, *.LDT і *.CIB з відповідної директорії.  
 

 
 

Рис. 3.31 
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 Виберіть закладку Вибір світильників у вікні Менеджер 

проекту. 

  Подвійним клацанням в списку світильників розкрийте панель 

Власний банк даних. 

 У списку № виробу закладки Знайти вкажіть ―*‖ – будь-хто. 

Справа висвітиться список знайдених в базі світильників. Виберіть 

світильник, який буде застосовуватися в проекті, із списку Знайдені і 

натисніть кнопку Перейняти. 

 Можна вибрати ще декілька інших типів світильників для 

локального освітлення окремих місць спортивної споруди. 

 Закрийте вікно – кнопка Закрити. 

При проектування освітлення футбольного поля введення світлових 

приладів було виконано наступним чином:  

– вхід у вкладинку вибір світильників: каталоги DIALux.  

– з переліку запропонованих програмою онлайн каталогів був 

вибраний General Electric Lighting.  

 

 
 

Рис. 3.32 – Вибір онлайн каталога СП 

 

Із переліку світлових приладів вибираємо той, що відповідає 

призначенню спортивної споруди,  і натискаємо додати у проект. 
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Рис. 3.33 – Вибір світлового приладу 

 

Надалі у вікні позиція/обертання вказуємо координати установки СП 

(за необхідності положення СП можна змінити за допомогою „миші‖). 

Кожен СП може бути зорієнтований за допомогою „миші‖ або за 

допомогою  позиція/обертання. 

10. Останній етап – розрахунок. Заходимо у командному меню в 

результати: запустити розрахунок. 
 

 
 

Рис. 3.34 – Розрахунок освітленності футбольного поля 
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11. Для уяви більш точної картини об'єкта ми можемо зробити 

візуалізацію за допомогою трасувальника  POV-Rаy. 
 

 
 

Рис. 3.35 – Вхід до трасувальника POV-Rаy 
 

 
 

Рис. 3.36 – Візуалізація за допомогою трасувальника POV-Rаy 
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Аналіз результатів розрахунку 
 

Найважливіша перевага програми DIALux – можливість різних форм 

представлення результатів розрахунку, що дозволяє проводити глибокий 

світлотехнічний аналіз. Для проглядання результатів розрахунку необхідно 

вибрати закладку Результати вікна Менеджер проекту. Результати 

розрахунків зібрані в групи: 

Загальні для проекту – «TEST» 

Світильники і їх характеристики, що використовуються: в нашому 

випадку це – GЕ ЕF2000S2000 

TEST_ROOM, де інформація так само згрупована: 

Загальна, для всього приміщення, включаючи інформацію про 

Розрахункові крапки. 

Результати розрахунку по кожній поверхні 3D сцени: 

 Ізолінії. 

 Градації сірого. 

 Графіки значень. 

 Таблиця значень. 

Всі результати можуть бути представлені як  по освітленості (E), так 

і по яскравості (L). 

Для проглядання результатів необхідно клацнути по відповідному 

елементу списку. Програма перейде до підготовки результатів розрахунку, 

на що потрібно якийсь час. Чекайте. Після відображення результату у вікні 

Інспектора стають доступні параметри даного типу представлення 

результатів: крок сітки, товщина ліній, відображення світильників, меблів і 

т.д. Кожний елемент в списку видачі має два прапорці: значок принтера 

означає включення до складу вихідної документації (встановлюється 

клацанням по полю прапорця) і червона галочка на значку листу, що 

означає доступність даного типу інформації. 

Наголосити на роздруковуваних сторінках можна і у властивостях у 

вікні Інспектора при виборі елементу «TEST». При цьому створений 

список сторінок звіту можна зберегти на диску, що дозволить позбавити 

від необхідності формування звіту кожного разу, а, з другого боку, 

дозволяє створити декілька типів звітів для різних цілей. 

Весь звіт в друкованій формі можна проглянути за допомогою 

Головне меню -> Файл -> Попередній перегляд. Після перегляду, звіт 

можна роздрукувати, як на принтері, так і на диску у форматі *.PDF, 

зручному для пересилки по електронній пошті. 
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Рис. 3.37 

 

Візуалізація сцени розрахунку ОУ 
 

Зображення 3D сцени в CAD-вікні є відображення результатів 

розрахунків освітлення приміщення методом випромінюваності, що не 

дозволяє врахувати дзеркальне відбиття, пропускання і шорсткість 

поверхонь і одержати фотореалістичне зображення. Фотореалістичне 

зображення ОУ в програмі DIALux отримується за допомогою сторонньої 

програми-трасувальника проміння POV-Ray (Persistance Vision Raytracer), 

при цьому спеціально адаптованої до задач DIALux.  

Запуск трасувальника здійснюється натисненням кнопки 

трасувальника POV-Ray на лінійці інструментів, що призводить до 

виведення на екран панелі установки параметрів трасування проміння. 
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Рис. 3.38 
 

Закладка Швидкі налаштування: 
 

Група Властивості зображення: 

Розмір – в пікселях. 

Прапор Згладжування – згладжування нерівностей растрування. 

Прапор Autobumpsmaps – генерація нерівностей текстури. 
 

Група Регулювання освітлення: 

Прапор Світильники згрупувати – розбиття світильників на 

частини. 

Список Опосередкований розрахунок – визначає точність 

розрахунку перевідбитого випромінювання. 
 

Група Настройка теки проекту: 

Місце на жорсткому диску директорії розміщення файлів 

підсумкового рендерингу. 
 

Група Додаткові налаштування: 

Прапор Зовнішні стіни приміщення зображати прозорими – 

відбракування нелицьових граней. 
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Прапор Згенерувати підлога – облік відбиттів від підлоги. 

Прапор Показати облаштування денного – зовнішні елементи 

сцени. 

Прапор Округляти сегментовані поверхні – округлення 

сегментованих поверхонь. 

Закладка Налаштування зображення: 

Поля Розмір зображення в пікселях – однозначно пов'язаний з 

Властивостями зображення. 

Закладка Опосередкований розрахунок: 

Прапор Використовувати Radiosity – еквівалентно вибору в списку 

Опосередкований розрахунок, закладки Основні параметри поля 

Деактивація. 

Поле count – кількість проміння, чим більше, тим вище 

опрацьовування деталей сцени. 

Поле error_bound – оцінка похибки розрахунку, істотно покращує 

розрахунок деталей, але може призводити до помилкових контурів – 

необхідно збільшувати count. 

Поле pretrace_start – початковий розмір елементів перегляду. 

Поле pretrace_end – кінцевий розмір елементів перегляду. 

Поле gray_treshold – зниження насиченості кольору за рахунок 

багаторазових відбиттів. 

Закладка Налаштування  яскравості: 

Поправочний    –  змінюється від 0 до 10. 

Значення менше 1 затемнює зображення, в світлих місцях видно 

більше деталей. 

Значення більше 1 освітлюють зображення, в темних місцях видно 

більше деталей. 

Проведіть візуалізацію сцени, натискаючи OK. Після виконання 

візуалізації Ви одержите растрове зображення, яке буде передане, в задану 

в групі Налаштування теки проекту директорію. 

 

Сцени освітлення і елементи управління 
 

Програма DIALux починаючи з четвертої версії, підтримує 

динамічне управління освітленням відповідно до стандарту DALI (Digital 

Addressable Lighting Interface). 

У DIALux існує можливість об'єднувати світильники в групи, при 

цьому задавати параметри їх включення і виключення, встановлювати, так 
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званий, «ступінь затемнення» для покрокової зміни кількості світла в  

3D сцені.  

Для управління освітленням в програмі використовуються Елементи 

управління, які дозволяють регулювати ступінь затемнення, колір світла, 

нахил, положення і КСС світильників, що знаходяться в певній групі. 

 Таким чином, маючи декілька різних по властивостях Елементів 

управління і об'єднавши їх в окрему групу, названу Сценою освітлення, 

можна моделювати автоматичне управління освітленням. 

У DIALux існує ряд правил (обмежень): 

 будь-який світильник або група світильників можуть бути додані 

     в Елемент управління; 

 світильник може входити в декілька Елементів управління; 

 сцена освітлення може містити один або декілька Елементів 

управління, проте в одній сцені не можуть бути одночасно 

Елементи управління, що включають однакові світильники. 

Щоб наочно продемонструвати регулювання освітлення в DIALux:  

1. Виділіть поле світильників клацанням миші в CAD-вікні або в 

Менеджері проекту. 

2. Праве клацання -> Розділити. 

3. Програма виведе запит ―Через поточні зміни результати 

розрахунків по наступних сценах недійсні: TEST_ROOM. Продовжити або 

ігнорувати результати розрахунків? (Ігнорування результатів розрахунку 

необоротно)‖. Натисніть Так. У Вас з'явиться в проекті дев‘ять незалежних 

світильників. 

4. Виділіть всі світильники, розташовані по периметру аудиторії – 8 

світильників. 

5. У Лінійці інструментів вибираємо Вставити -> Елемент 

управління, або за допомогою контекстного меню по правій кнопці миші 

Додати до елементу управління -> Новий елемент управління. Новий 

Елемент управління з'явитися в Менеджері проекту з відповідними 

властивостями в Інспекторі. 

6. Виділіть Новий Елемент управління в Менеджері проекту і у 

властивостях Інспектора вкажіть ім'я – Периметр. 

7. Аналогічно створіть Елемент управління під ім'ям – Середина, в 

який внесіть світильник, що залишився. 

8. Потім необхідно створити сцену освітлення, для цього можна 

скористатися одним з трьох шляхів: 
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Заходимо в головне меню і вибираємо Вставити -> Сцена освітлення. 

З контекстного меню правим клацанням в Менеджері проекту на 

рядку приміщення TEST_ROOM вибрати Ввести сцену освітлення 

кнопкою Нова сцена освітлення з лінійки інструментів. 

9. У властивостях Інспектора на закладці Сцени освітлення задайте 

ім'я сцени – Освітлення по периметру. Прибравши прапорець на закладці 

Коефіцієнт денного світла, можна включити в сцену денне світло, 

встановивши прапорець – При розрахунку брати до уваги денне світло.  

На закладці Значення затемнення поданий список коефіцієнтів 

затемнення, який можна редагувати. Задані коефіцієнти затемнення можна 

вивести в CAD-вікні по кнопці – Показати значення затінювання в CAD 

або через головне меню – Вигляд. 

10. За допомогою контекстного меню по правій кнопці на рядку 

Елементи управління -> Периметр -> Додати до сцени освітлення або 

на рядку відповідної Сцени освітлення – Освітлення по периметру -> 

Ввести елемент управління.  

В Інспекторі на закладці Значення затінювання доступні значення 

коефіцієнтів затемнення, а на закладці Колір освітлення визначається колір 

візуалізації в POV-RAY. 

11. Аналогічно створіть сцену освітлення в центрі під ім'ям – 

Освітлення в середині і включите в неї елемент управління – Середина. 

12. Розрахуйте сцену освітлення. 

13. На 3D виді, що відкрився, буде Сцена Освітлення в центрі. Для 

перемикання відображення сцен можна скористатися кнопками  

Попередня / Наступна сцена освітлення на лінійці інструментів або правим 

клацанням -> Використати сцену освітлення для CAD. 

 

Природне освітлення 
 

Світлові моделі в програмі DIALux відповідають CIE 110-1994 

"Spatial Distribution Daylight – Luminance Distributions Various Reference 

Skies".  

Таким чином, кожній точці неба задана певна яскравість, яка 

залежить від положення Сонця, пори року і доби. Для розрахунків денного 

освітлення в проекті повинно бути присутнім окрема Сцена освітлення 

(рисунок 3.39). 
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Рис. 3.39 

 

1. Створіть нову сцену освітлення під ім'ям – Природне освітлення. 

2. У Інспекторі властивостей елементу TEST в Менеджері проекту на 

закладці Місце розташування можна задати положення точки на Земній 

кулі із списку Місце – Moscow. 

3. У Інспекторі властивостей елементу сцени Природне освітлення в 

Менеджері проекту на закладці Місце положення задайте прапор При 

розрахунку взяти до уваги денне освітлення і зніміть прапорець 

Розрахувати індекс денного освітлення, якщо він встановлений. 

4. У списку Модель неба виберіть Чисте небо і поставте прапорець 

Пряме сонячне світло. 

5. Виділіть елемент TEST_ROOM в Менеджері проекту і в Інспекторі 

на закладці Орієнтування (інакше командою з Провідника – Встановити 

орієнтацію на північ) встановіть Орієнтацію на 45. В кожній сцені 

освітлення напрям на північ визначається стрілкою на вигляді в CAD-вікні. 
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По кнопці Візуалізація сонячного світла і тіні в CAD-вікні виводиться 

розподіл світла і тіні засобами OpenGL, а в Інспекторі відкривається 

закладка з двома движками: часу доби і року. Параметри пропускання світла 

склом встановлюються при виділеному елементі Вікно в Інспекторі на 

закладці Коефіцієнт денного світла і дозволяє врахувати пропускання світла 

склом, забруднення приміщення і затінювання елементами рами. Для всіх 

значень можливе чисельне введення і вибір з якісного списку. Всі значення 

задаються за умовчанням при вставці елементу Вікно в приміщення. Модель 

неба й інші параметри денного освітлення встановлюються в Інспекторі на 

закладці Коефіцієнти денного неба при виділенні Сцени освітлення. 

6. Виберіть команду Обробити облаштування в Провіднику в 

закладці Денне світло, по якій можна розташувати затінюючі об'єкти 

перед вікнами будинку. Буде виданий запит про зміну сцени, його 

необхідно підтвердити. Далі в цей режим можна переходити через меню 

Обробити -> Обробити облаштування, або правим клацанням на 

TEST_ROOM в Менеджері проектів той же пункт або з використанням 

відповідної закладки в CAD-вікні. 

7. У Менеджері проекту виберіть закладку Облаштування для 

TEST. В CAD – вікні розташуйте Ваше приміщення так, щоб зручно було 

розташовувати об'єкти перед вікном. 

8. Виберіть закладку Файли з Меблями панелі Менеджер проекту із 

списку Зовнішнє приміщення -> Будівля -> Стара споруда 1, і розташуйте 

його перед вікном. Для зручності скористайтеся виглядом План. 

9. Виконайте розрахунок тільки сцени природного освітлення. 

Оцініть відмінності, що з'явилися. 

 

Складна геометрія освітлення 
 

1. Збережіть проект. 

2. Закрийте проект: Файл -> Закінчити. 

3. Створити новий проект можна, натискаючи кнопку Новий або 

Нове приміщення, Нова зовнішня сцена, Нова стандартна вулиця на лінійці 

інструментів, або меню Файл -> Новий, або з клавіатури Ctrl+N. 

Стандартний діалог, що виникає при старті DIALux, можна викликати з 

меню «?» -> Показати стандартний діалог DIALux. 

Дуже ефективне використання Асистентів – Файл -> Асистенти: 

DIALux Light – дозволяє підготувати стандартний (спрощений) 

світлотехнічний проект і зберегти його в DIALux. 
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Імпорт DWG і DXF файлів – організовує роботу з DIALux з 

файлами креслень у відповідних форматах. 

3D – імпортування і обробка – здійснює завантаження і 

редагування 3D сцен у форматі *.3DS, з подальшим розрахунком 

розрахунком освітлення в DIALux. 

Структури полів і Групи лінійок – розстановка і компонування 

світильників по всьому приміщенню або уздовж однієї заданої лінії.  

Прискореної компоновки в двох варіантах: звична – розвинений 

діалог, і для професіоналів – укорочений діалог. 

Для спеціальних типів приміщень: склепінчасте, L-видне, 

прямокутне, полігональне. 

Прискорене освітлення вулиць в двох варіантах: компонування 

вулиць – теж що і DIALux Light, тільки для вуличного освітлення, і 

оптимальна група вуличних світильників – набір засобів для оптимізації 

параметрів дорожнього освітлення для професіоналів.  

 

Налаштування програми DIALux 
 

Основні налаштування програми і величини, що використовуються 

за умовчанням, можна змінити Файл -> Настройки -> Загальні опції, що 

приведе до появи панелі діалогу.  

Меню Файл -> Налаштування -> Набудувати панелі інструментів і 

клавіатуру - дозволяє підігнати інтерфейс програми під користувача. 

Відновити початковий інтерфейс можна по команді «?» (Довідка) -> 

Відновити операційне середовище. 
 

  
 

Рис. 3.40 
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Вихід з програми DIALux 
 

Команда Закінчити в головному меню Файл або Alt + F4. У випадку, 

якщо Ваш проект ще не був збережений, програма запитає у Вас про 

збереження. Для самоконтролю використовуйте архів DIALux_test.zip.  

Приклади, що ілюструють створення ОУ спортивних споруд в 

розглянутій програмі, наведені на рисунках 3.41, 3.42, 3.43, 3.44.  
 

 
 

Рис. 3.41 – Визначення розмірів щогли в реальному часі  
 

 
 

Рис. 3.42 – Професійний рівень роботи з новими параметрами 

―прожектора‖. Світильники з різними типами ламп розташовані як 

дзеркальне відбиття один одного 



 181 

 

 

Рис. 3.43 – Приклад системи освітлення закритої спортивної споруди в 

DIALux 4.6 

 

 

 

Рис. 3.44 – Розрахунок  характеристик освітлення в реальному часі 

 

Отже проектувальник може без значних зусиль створити 

найякіснішу і прийнятнішу систему освітлення. Версії програми                   

DIALux 4.6 і новіші зараз дозволяють проектувати спортивні системи 

освітлення так добре, як інтер‘єрне і вуличне освітлення. 



 182 

3.6 Проектування освітлювальної установки спортивних споруд 

у програмі EUROPIC 

 

Завдання розрахунку освітлення зводиться до визначення необхідної 

кількості світлових приладів для створення нормованого значення 

освітленості на спортивних об'єктах. При цьому розроблений проект 

освітлення повинен забезпечувати мінімальні витрати на спорудження та 

експлуатацію освітлювальної установки. 

 

 
 

Рис. 3.45 

 

Загальні відомості про програму EUROPIC 
 

EUROPIC – це комп'ютерна програма призначена для проектування 

світлотехнічної частини освітлювальних установок як внутрішнього, так і 

зовнішнього освітлення. EUROPIC дозволяє проектувальнику вибрати тип і 

колір поверхонь приміщення, заповнити простір приміщення елементами 

інтер'єру, вибрати рівень робочої поверхні, вибрати тип і КСС світлового 

приладу з бази, розмістити освітлювальні прилади і т.д. Використовуючи 

засоби EUROPIC можна розрахувати горизонтальну, вертикальну, 

циліндричну освітленість в приміщенні, а також провести тривимірну 

візуалізацію для отримання наочної картини розподілу освітленості в 

приміщенні. Причому, при розрахунку освітленості будуть враховані як 

вибрані проектувальником характеристики приміщення, так і відбита 

освітленості від поверхонь приміщення і предметів фурнітури. 

 

ОГЛЯД ДЕТАЛЕЙ ІНТЕРФЕЙСУ ПРОГРАМИ EUROPIC 
 

Хоча інтерфейс програми EUROPIC є англомовним, загальні 

властивості вигляду успадковані від інших додатків операційної системи 

Windows. 
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Основна відмінність полягає в тому, що разом із запуском основного 

додатку автоматично запускається фотометричний сервер, який 

знаходиться в згорнутому стані в процесі роботи з програмою. 

При запущеній програмі на моніторі зверху вниз помітні наступні 

основні елементи інтерфейсу: 

1.  Рядок документа – рядок з назвою програми і її версією, а також 

з назвою поточного документа. 

2. Рядок меню – рядок доступу до пунктів меню з основними 

командами. 

3. Рядок редагування – рядок з кнопками швидкого доступу до 

команд редагування. 

4. Вікно редагування – основна робоча область документа (область, 

де ведуться побудови і розрахунки). 

5. Вертикальна і горизонтальна смуги прокрутки. 
 

Рядок меню 

У рядок меню входять наступні основні пункти: 

1. File – команди роботи з файлом (Open – відкрити, Save – зберегти, 

Print – друкувати, Import – імпортувати, Export – експортувати і ін.). 

2. Room/area – команди вибору типа і характеристик приміщення або 

зовнішнього об'єкту. 

3. Furniture – команди вибору елементів інтерфейсу і їх 

характеристик. 

4. Luminaires – команди вибору освітлювального приладу. 

5. Calculations – обчислення – пункт меню з командами обчислення 

освітленості, застосовувати ці команди варто після того, як проектування 

ОУ закінчено (після розміщення ОП). 

6. Images – зображення – команди роботи із зображеннями, 

одержаними після візуалізації. 

7. Options – команди налаштування документа при роботі з об'єктами 

(налаштування осей координат, сітки і т.д.). 

8. Results – виведення результатів обчислень в тій або іншій формі. 

9. View – команди вибору вигляду в тій або іншій проекції ОУ. 

10. Help – допомога в програмі EUROPIC. 

Рядок форматування є змінним – при роботі з тим або іншим 

елементом установки виводяться кнопки швидкого доступу до необхідних 

команд редагування. 
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Проектування освітлювальної установки  в EUROPIC 

 

1 етап. Відкрити пункт меню Room/Area і вибрати команду Create 

(створити), після чого у вікні редагування за допомогою покажчика миші 

побудувати контур приміщення. Приміщення вважається побудованим, 

коли контур замкнутий. Встановити крок сітки, рівний 0.25 м. Після цього 

на екрані з'явиться таблиця характеристик приміщення. У вікні таблиці 

можна задати висоту приміщення, тип приміщення (внутрішнє, зовнішнє), 

матеріал обробки приміщення, коефіцієнти відбиття поверхонь, висота 

розрахункової поверхні. Контур приміщення можна не креслити, якщо 

скористатися закладеними в бібліотеку програми типами приміщення. Для 

цього необхідно відкрити підпункт меню Library в меню Room/Area. Якщо 

ви проектуєте зовнішнє освітлення або освітлення тунеля, в цьому випадку 

необхідно скористатися підпунктами меню Street або Tunnels з того ж 

меню. 

2 етап. Розстановка фурнітури в приміщенні. Відкрити пункт меню 

Furniture і вибрати одну з команд або Create Box – створити короб або 

Add furniture – додати фурнітуру. Перша команда дозволяє створити 

геометричний об'єкт у вигляді короба, вибравши координати розміщення   

в приміщенні, геометричні розміри, колір і коефіцієнт відбиття об'єкту. 

Необхідно дати назву створюваному блоку у верхній частині вікна. 

Створений об'єкт можна переміщати в полі вікна редагування, виділивши 

його і перетягуючи за допомогою покажчика миші (натискають ліву 

кнопку при перетягуванні). При виборі команди додати фурнітуру   

з'являється вікно з пропонованими об'єктами інтер'єру. Після вибору того   

або іншого об'єкту в спливаючому вікні, в правій частині вікна з'являється 

зображення цього об'єкту. Вибраний об'єкт можна дублювати, переміщати 

і т.п. 

3 етап. Вибір і розміщення світильників. Відкрити пункт меню 

Luminaures і вибрати команду Add luminaire – вибрати світильник або 

команду Add luminaires automatically – додати світильники автоматично. В 

першому і другому випадку у випадаючому вікні необхідно вибрати тип 

світильника з групи Interiors – внутрішні, по типу світильника, типу КСС і 

потужності лампи в світильника. Після вибору типу світильника необхідно 

вибрати тип джерела світла і його світловий потік. Після чого світильник 

можна також дублювати і розміщувати в приміщенні. 
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4 етап. Розрахунок освітленості. Вибрати в пункті меню Calculation 

команду Start. У вікні, що з'явилося, можна налаштувати параметри  

розрахунку освітленості, задавши тип освітленості. Після розрахунку буде 

виведена таблиця розподілу освітленості в приміщенні. Для отримання 

площинних і просторових графіків розподілу освітленості в приміщенні 

необхідно зайти в пункт меню Results і вибрати команду Select Surface – 

вибрати поверхню. Під вікном редагування з'являться кнопки вибору 

проекції приміщення. Вибрати потрібну проекцію і клацнути лівою 

кнопкою миші по рисунку. Контур рисунка змінить колір. Тепер 

натиснення кнопки ОК виводить на екран вікно вибору типу діаграми. 

5 етап. Візуалізація. В пункті меню View вибрати пункт Camera. На 

екрані з'явиться тривимірне зображення проектуємого приміщення і 

віконця для того, щоб встановити зображення під зручним кутом. 

Вибравши потрібний ракурс необхідно натиснути кнопку Render –   

виконати. Підвести покажчик миші до центру зображення, поміченого 

невеликим хрестиком. Кнопок на миші натискати не треба. Після чого 

необхідно відвести покажчик миші, так само без натиснення кнопок миші, 

і виділити за допомогою рамки, що з'явилася, необхідну область рисунка і 

натиснути ліву кнопку миші. У вікні, що з'явилося, можна точніше 

набудувати розміри зображення візуалізації, задати колір підкладки   

зображення, задати тип візуалізації, вказати предмети, що підлягають 

візуалізації, і натиснути кнопку ОК. 

6 етап. Збереження зображень, одержаних після візуалізації. В 

пункті меню Images вибрати команду Save and delete images – зберегти і 

видалити зображення. У випадаючому вікні можна вибрати ті зображення, 

які будуть збережені, а також видалити непотрібні зображення. 

Зображення в EUROPIC зберігаються у форматі *.bmp. 

Перед початком побудов в програмі EUROPIC рекомендується 

проглянути чотирихвилинний навчальний кліп, що ілюструє основи 

роботи з програмою від початкового до кінцевого етапів. Щоб запустити 

мультиплікаційне зображення необхідно відкрити з меню 

Пуск / програми / EUROPIC / Tutorial (навчання). Протягом розвитку 

навчального кліпу даватимуться коментарі на англійській мові. У будь-

який момент кліп можна зупинити, натискаючи на кнопку «пауза», після 

чого відновити відтворення, подібно тому, як це робиться у всіх відомих 

типах програвачів, призначених для роботи в середовищі Windows. 
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Розрахунок кількісних і якісних показників освітлення для 

внутрішніх освітлювальних установок за допомогою програми 

EUROPIC 

 

Команда дозволяє розрахувати  проект освітлення, з обчисленням 

освітленості і яскравості поверхонь Приміщення/Області, включаючи 

меблі, а також виконати економічний розрахунок установки. 

 

Іконка 

 
Іконка – Почати Розрахунок 

 

Розрахунок Освітленості і Яскравості (Iluminance and Luminance 

Values Calculation) 

При виборі команди Розрахунок, з'являється вікно, зображене на 

рисунку, в якому задаються наступні параметри:  

Тип Розрахунку (Calculation 

Type): програма пропонує 3 види 

розрахунку: 

 Спрощений (Simplified): 

обчислення проводиться за 

алгоритмом, що міститься в 

рекомендаціях CIE 52, який не 

враховує тіні від предметів і самі 

предмети типу меблів. Алгоритм вірний тільки в наступних ситуаціях: 

 у приміщеннях у формі паралелепіпеда; 

 коли світильники мають широкий світлорозподіл;  

 коли поверхні приміщення, і, зокрема, підлога мають коефіцієнт 

відбиття менше, ніж 75%. 

Якщо параметри виходять за дані межі, можливі значні помилки в 

розрахунку.  

Рекомендується користуватися цим методом розрахунку з-за 

швидкості отримання результату на початку розробки проекту.  

 Тільки Пряме Світло (Only Direct): обчислення грунтуються на 

розрахунку тільки прямого світла, коли не враховуються багаразові 

відбиття між стінами або іншими поверхнями.  

 Повне Світло (Complete): розраховуються як пряма, так і відбита 

складова світла, враховуються багаторазові відбиття між всіма поверхнями 

 

Параметри розрахунку 
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(включаючи меблі). Рекомендується задавати розрахунок 7 перевідбиттів, 

при більшому числі результат істотно не зміниться. 

Вибір того або іншого типу розрахунку здійснюється клацанням 

миші по віконцю зліва від найменування методу. 

 Тіні і/або Облік Меблів (Shadows and/or Furniture Calculation): 

програма розраховує основні світлотехнічні параметри, враховуючи при 

цьому тіні, створені предметами меблів. Для вибору однієї або всіх опцій 

клацніть лівою клавішею миші напроти рядка Тіні і Меблі (Shadows and/or 

Furniture): з'явиться галочка .  

Параметри розрахунку (Calculation Parameters): параметри, які 

обчислюються програмою:  

 Освітленість (люкс) (Illuminance [lux]): цей параметр 

обчислюється завжди; 

 Яскравість (кд/м
2
) (Luminance [cd/m

2
]): вибрати функцію Ви 

можете, клацнувши лівою клавішею миші по ній; зліва повинна з'явитися 

галочка . 

 Вузли Сітки Обчислень (Grid): може бути задано вручну або 

обчислено автоматично. Якщо Ви вибираєте автоматичний розрахунок, 

крок сітки задається, виходячи з розмірів кімнати і меблів. Клацнувши на 

віконці Automatic, Ви прибираєте галочку і вимикаєте автоматичний вибір 

кроку сітки. Тепер Ви можете ввести величину кроку сітки в [м] як в 

подовжньому, так і поперечному напрямах. Дані величини залишаються 

однаковими для всіх поверхонь. 

Застосування вільної сітки повинно використовуватися лише у 

випадках, коли меблі відсутні: дуже великий крок сітки призведе до 

можливого попадання тільки одного вузла розрахунку на поверхню 

елементу меблів і до некоректного результату при рендеринзі. 

 Позиція Спостерігача (Observer Position): у випадку, якщо Ви 

вибрали розрахунок яскравості, програма активує додаткове вікно для 

введення місцеположення спостерігача x, у і z. Насправді, положення 

спостерігача і напрям його погляду критичні лише для розрахунків 

вуличного освітлення, коли використовуються таблиці коефіцієнтів 

відбиття R- і C-. У всіх інших випадках яскравість дифузно відбиваючих 

поверхонь не залежить від положення спостерігача. 

Для виходу з вікна натискніть Cancel, ОК – для початку обчислень. 
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У процесі обчислення на екрані з'являється вікно, що показує стадію 

розрахунку. Програма спочатку обчислює пряму, а потім відбиту складову 

світла.  

Алгоритм роботи в EUROPIC виглядає таким чином: 

 визначте тип і розміри кімнати і розмістіть світильники і меблі; 

 зробіть розрахунок з автоматичним кроком сітки тільки прямої 

складової світла (Only Direct) і/ або спрощений розрахунок (Simplified); 

 якщо потрібно, відкоректуйте проект. Пам'ятайте, що пряма 

складова дає до 60-80% освітленості від прямого і відбитого світла; 

 зробіть необхідні доповнення і повторіть розрахунок;  

 отримавши задовільний результат, повторіть обчислення, 

враховуючи багаторазові відбиття, тіні і меблі. 

Коли обчислення завершено, з'являється вікно, яке підтверджує, що 

обчислення зроблено коректно. Клацніть ОК, і програма поверне Вас в 

Робочу Область. 

Для проглядання таблиці результатів і графіків (ізолінії, діаграму 

світлової плями і тривимірні), необхідно вибрати команду Results з 

верхнього рядка меню. 

 

Розташування освітлювальних щогл при проектуванні 

освітлювальних установок спортивних споруд 
 

Додати щоглу (Add Mast). Ця функція дозволяє вводити об'єкт типу 

щогли, що розглядається як група (геометрична) світильників, 

розташованих на одній щоглі. 

Після вибору функції на екрані з'являється діалогове вікно, в якому 

визначаються наступні параметри щогли: 

 Ім'я (Name): ім'я, яке Ви привласнюєте щоглі (наприклад: Mast 1 

або South Mast). 

 Габарити Х і У (X and У Dimensions) [м]: показують габарити 

оголовка щогли, на якій встановлені світильники. 

 Кількість рядів і колонок (Number Rows and Columns): кількість 

рядів і колонок, розташованих на оголовці щогли, добуток цих чисел дає 

загальну кількість світильників на оголовці.  

 Розташування (Position) [m] (x, у, z): абсолютні координати 

розташування (x і у) і висота (z) щогли.  
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 Прицілювання (Aiming): це напрям прицілювання оголовка щогли 

з світильниками, що визначається координатами х, у, z [м] і кутом 

обертання самої щогли [°] (в цьому випадку точка прицілювання – це 

точка перетину осі оголовка щогли, яка перпендикулярна площині 

установки світильників і проходить через центр тяжкості оголовка й 

розрахункової площини. Оголовок також можна повертати навкруги цієї 

осі, тому необхідно задати поворот самого оголовка) або полярними 

координатами (Rot x, у, z) [°], коли оголовок обертається навкруги своїх 

осей відносної системи координат (x, у, z), паралельним осям абсолютної 

системи. 

Як тільки всі параметри будуть визначені і підтверджені, програма 

перенесе щоглу в Робочу Область.  

Тримаючи мишу на зображенні щогли і натискаючи на праву 

клавішу, викликаєте меню наступних команд: 

 Видалити Щоглу (Delete Mast) – видаляє виділену щоглу.  

 Перемістити Щоглу (Move Mast) – зсув задається в діалоговому 

вікні з вказівкою координат (x, у, z), виражених в [м]. 

 Обертання відносне навкруги осі Z (Must Relative Rotation) – 

щогла обертається навкруги своєї вертикальної осі; кут обертання [°] 

задається в діалоговому вікні.  

 Зміна параметрів прицілювання (Aiming Modification) – зміна 

таких параметрів щогли, як: ім'я, кількість рядів і колонок в оголовці, 

координати положення (x, у, z) і напрям прицілювання; використовується 

діалогове вікно, аналогічне команді Add Mast.  

 Прицілити Щоглу (Aim Mast) – дозволяє графічно прицілити 

оголовок щогли; при виборі цієї функції з'являється діалогове вікно для 

введення координати площини, в якій інші координати указуються мишею 

(«площина миші»). Це викликано тим, що Ви працює тільки з двовимірним 

виглядом і необхідно вказати відсутню координату. Вибравши відстань 

між «площиною миші» і відповідною декартовою площиною, звичайно 

XY, і відносний кут повороту оголовка щогли, натисніть OK. Програма 

графічно покаже промінь, що виходить з оголовка і спрямований мишею. 

Рухаючи мишу, вкажіть необхідний напрям прицілювання і орієнтацію 

оголовка. 

 Список Світильників (Luminaires List) – функція введення 

світильників на щоглу, діє незалежно від вже визначених раніше окремих 

світильників. 
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Список світильників (Luminaires List) 

 

При виборі цієї функції на екрані з'являється діалогове вікно, що 

містить параметри світильників, які належать вибраній щоглі. 

Вікно містить верхню і нижню частини, в останній розташовуються 

кнопки управління. 

У верхній частині містяться наступні команди, в порядку зліва 

направо: 

 Колонка вибору; для виділення світильника клацніть зліва від його 

імені; якщо Ви хочете виділити відразу декілька світильників, виділяйте їх 

курсором миші, тримаючи натиснутою клавішу клавіатури Control (Ctrl); 

світильник виділений, коли з'являється галочка  . Для відміни виділення 

повторіть дію. 

 Позначення світильника (для швидкого пізнання). 

 Ряди і колонки; програма автоматично привласнює номери 

позицій, починаючи з ряду 1 колонки 1 в лівому нижньому кутку оголовка, 

якщо дивитися зверху. 

 Координати розташування центру тяжкості світильників відносно 

декартових осей (xb, yb, zb) [м] (відповідно до координат центру тяжкості 

оголовка). 

 Прицілювання світильника – напрям світлового жмутка, що 

задається декартовими координатами (xp, yp, zp) і кутом повороту 

навкруги оптичної осі (ra), або полярними координатами (поворот 

навкруги декартових осей світильника x, y, z). 

Відредаговані можуть бути тільки колонки з  найменуванням і 

координатами прицілювання. 

У нижній частині вікна розташовані наступні функції:  

 ON: включає світильник для розрахунку. 

 OFF: вимикає світильник з розрахунку. 

 Вставити (Insert): дозволяє ввести новий світильник вибраного 

типа, який з'являється внизу списку світильників. 

 Прицілити (Aim): дозволяє прицілити окремий світильник мишею 

з використанням «площини миші». Діє аналогічно команді Прицілити 

Щоглу (див. вище). 

 Видалити (Delete): видаляє виділений світильник; будь-яке 

видалення повинне бути підтверджено користувачем. 
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 Змінити Коефіцієнт Обслуговування (MaintCoeff): дозволяє 

змінити коефіцієнт обслуговування виділеного світильника; у вікні, що 

з'являється, вкажіть величину коефіцієнта і натисніть ОК для 

підтвердження даних 

 Світильник (Luminaire): команда доступу до файлу, що містить 

різні типи світильників (див. розділ LUMINAIRE/Add Luminaire). Новий 

вибраний тип світильника замінює старий і за умовчанням 

використовується при введенні нових світильників. 

 OK: для підтвердження змін і повернення в Робочу Область.  

Порада: якщо Ви хочете розмістити різні типи світильників на один 

оголовок, ми пропонуємо Вам спочатку заповнити список одним типом 

світильників, а потім за допомогою функції Luminaire окремі світильники 

замінити на потрібні. 
 

Список Щогл (Masts List) 
 

Знаходячись в робочій області, натисніть праву клавішу миші. 

З'явиться контекстне меню, в якому Ви можете вибрати функцію Список 

Щогл (Mast List), управляючу параметрами щогл. 

Вікно розділено на дві частини: верхня містить параметри щогл, а 

нижня – функції управління таблицею.  

Таблиця складається з наступних колонок (зліва направо): 

 Колонка вибору; для виділення щогли клацніть зліва від її імені; 

щогла виділена, коли з'являється галочка  . Для відміни виділення 

повторіть дію. 

 Порядковий номер щогли. 

 Найменування щогли (позначення для швидкого розпізнавання 

щогли) 

 Число рядів і колонок на оголовці щогли. 

 Координати розташування оголовка щогли на плані відносно 

абсолютних декартових осей X, У, Z [м]. 

 Орієнтація щогли в просторі, що виражена або в декартових 

(xp, yp, zp і ra – поворот навкруги власної осі), або в полярних координатах 

(поворот навкруги декартових осей щогли x, y, z). 

Всі дані можуть редагуватися. 

Нижня частина вікна містить наступні функції: 

 Вставити (Insert): ввести нову щоглу. 
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 Перемістити (Move):  переміщає виділені щогли в будь-яких 

напрямах (x, у і z). Використовуйте вікно, що з'являється, після вибору цієї 

опції: введіть дані і натисніть ОК для підтвердження переміщення 

вибраних щогл. 

 Видалити (Delete): видаляє виділену щоглу; будь-яке видалення 

повинне бути підтверджено користувачем 

 Оголовок Щогли (Panel): дозволяє змінити розміри x і у оголовка 

щогли 

 OK: підтвердження змін і повернення в Робочу Область 
 

Копіювати Щоглу (Duplicate Mast) 
 

Функція дозволяє копіювати вибрану щоглу, створюючи один або 

декілька дублікатів з тими ж характеристиками, з тією ж кількістю 

світильників на щоглі і з тими ж параметрами прицілювання.  

На екрані з'являється вікно, де Ви можете визначити, яким способом 

провести копіювання щогли (перший спосіб – використання доступних 

параметрів, другий – графічний). 

У першому випадку визначаються параметри типу:  

 кут напряму [°] лінії, на якій буде розташована копійована щогла. 

Значення 0 показує позитивний напрям по осі X; 

 відстань між двома послідовно розташованими щоглами [м]; 

 кількість копійованих щогл. 

Після натиснення ОК програма створює копії в Робочій Області. 

У другому випадку, вибираючи функцію Aiming with Mouse, 

програма автоматично показує щоглу з сегментом, що сполучає саму 

щоглу і курсор миші. Таким чином, Ви відразу визначаєте напрям і 

довжину сегменту. Після визначення напряму і довжини сегменту, 

натисніть ліву клавішу миші. З'явиться вікно, в якому необхідно вказати 

кількість копійованих щогл. Після натиснення ОК, програма переносить 

копії в Робочу Область. 
 

Копіювати Щоглу Симетрично (Symmetrize Mast) 
 

Ця функція дозволяє симетрично розташувати копійовані щогли, 

створюючи одну або три симетричні копії, які мають ту ж кількість 

світильників, що і оригінал, але з симетричним розташуванням і 

прицілюванням . 

Є два різні типи симетрії: 
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 Простий – вертикальний або горизонтальний, щогла копіюється 

симетрично оригіналу. 

 Подвійний – вертикальний і горизонтальний одночасно, 

копіюються 3 щогли, симетричні оригіналу. 

Створення симетричних копій щогл можливе тільки на площині. 

Програма відображає діалогове вікно, в якому визначаються 

наступні параметри симетричності щогл: 

 Центр симетрії: крапка, вказуюча вісь симетрії (простий тип) або 

вісь симетрії (подвійний тип).  

 Тип симетрії: є три різні типи симетрії: 

Горизонтальний (Horizontal): нова щогла розташована симетрично 

оригіналу відносно горизонтальної осі, що проходить через центр симетрії; 

визначається тільки координата у. Нові щогли розташовуються уздовж осі У.  

Вертикальний (Vertical): нова щогла розташована симетрично 

оригіналу відносно вертикальної осі, що проходить через центр симетрії; 

визначається тільки координата х. Нові щогли розташовуються уздовж осі Х. 

Вертикально-горизонтальний (Vertical/Horizontal): створюються 3 

нові щогли, симетричні оригіналу відносно вертикальної і горизонтальної 

осей, що проходять через центр симетрії. В цьому випадку задаються 

координати цього центру x і у. Симетричні копії розташовуються уздовж 

осей X і У. 

Натисніть ОК для введення нових щогл в Робочій Області.  
 

Перемістити Світильник (Move Luminaire) 
 

Для того, щоб перемістити світильник в Приміщенні/Області, введіть 

значення у вікні, показаному на рисунку, що з'являється. 

Зсув визначається координатами x, у і z. Після того, як Ви задасте 

величини зсуву і натиснете ОК, програма перемістить світильник на нову 

позицію. 

Примітка: перемістити світильник Ви можете також за допомогою 

миші. Для цього виділіть світильник і, не відпускаючи ліву клавішу миші, 

перетягніть його на нову позицію, потім відпустіть клавішу. 

Світильник буде переміщений на нову позицію. 
 

Повернути Світильник (відносно осі Z) (Rotate Luminaire                   

(Relative along Z)) 
 

Команда дозволяє обертати світильник навкруги вертикальної осі, 

що проходить через центр тяжкості світильника. Після вибору цієї 
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команди на екрані з'являється показане на рисунку вікно. Введіть кут 

повороту і натисніть ОК. Програма може повертати світильник тільки 

навкруги вертикальної осі Z на 360°. Обертання відбувається за 

годинниковою стрілкою, якщо дивитися на Приміщення в плані. 
 

Змінити Параметри Світильника (Aiming Modification) 
 

Ця команда дозволяє змінити ім'я, коефіцієнт обслуговування, 

координати місця розташування в прямокутній системі координат x, у, z і 

параметри прицілювання вибраного світильника в прямокутній або в 

полярній системах координат. Параметри, що змінюються, і вид 

діалогового вікна повністю аналогічні тим, які вводяться командою Add 

Luminaire. 
 

Прицілити Світильник (Aim Luminaire) 
 

При виборі цієї функції з'являється вікно, що містить:  

 Площина (Plane): бракуюча координата [м] «висоти» 

двомірної площини, по якій переміщається курсор миші («площина 

миші»). Наприклад, якщо поточний двовимірний вигляд – Робоча Область 

(показані координати X і У), то відсутня координата, яку треба вказати – Z. 

 Власна Вісь Обертання (Z intr.): поворот світильника в [°] 

навкруги своєї оптичної осі (осі, перпендикулярної області 

розповсюдження світла). Наприклад, у разі люмінесцентного світильника 

поворот з Z  = 0° завжди означає горизонтальне розташування ламп, тоді 

як при Z = 90° положення ламп – вертикальні. 

Після натиснення OK програма покаже двовимірний вигляд, 

вибраний світильник і його оптичну вісь, яка закінчується на курсорі миші, 

що показує точку прицілювання. Рухаючи мишу, Ви змінюєте приціл 

світильника і, відповідно, його поворот. 
 

Виділити Групу Світильників (Multiple Selection) 
 

Ця функція дозволяє Вам за допомогою миші виділити область, 

усередині якої вибираються світильники, які згодом можуть бути 

одночасно переміщені або змінені в Списку Світильників (Luminaires list).   

Виконайте наступну послідовність дій: 

1. Виберіть команду Multiple Selection з меню. 

2. З'являється план (вигляд зверху) Робочої Області, на якому 

Вам треба визначити область навколо світильників, що позначаються. Для 
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цього клацніть мишею на плані і визначте початкову точку області. Далі 

після кожного клацання миші  програма креслить сегменти, що створюють 

сторони області. Область закривається клацанням на початковій точці. 

3. Як тільки область буде закрита, програма відкриває вікно із 

Списком Світильників, де вибрані світильники (окресленої області, що 

знаходяться всередині) відмічені в лівій крайній колонці галочкою . 

Це вікно містить наступні колонки (зліва направо): 

 Виділення світильника: поставте значок  у порожньому віконці 

напроти найменування світильника клацанням миші; 

 Порядковий номер світильника; 

 Позначення світильника (для швидкого розпізнання);  

 Коефіцієнт Обслуговування в межах від 0 до 100%; 

 Координати центру світильника в абсолютних осях x, у, z [м]; 

 Орієнтація світильника в просторі, виражена в прямокутних 

координатах (xp, yp, zp і ra – кут повороту навкруги осі світильника) або в 

полярних координатах (обертання навкруги декартових осей x, y, z). 

Всі параметри, окрім перших двох, редагуються. 

Нижня частина вікна містить наступні функції:  

 ON: включає світильник для розрахунку 

 OFF: вимикає світильник з розрахунку 

 Вставити (Insert): додає світильник вибраного поточного типу, 

світильник буде вставлений в кінці списку. 

 Перемістити (Move): переміщує помічені світильники в будь-

яких напрямах x, у і z за допомогою вікна, що з'являється після вибору  цієї 

команди. Введіть дані і натисніть OK для підтвердження переміщення 

помічених світильників. 

 Видалити (Delete): видаляє помічені світильники (для вибору 

світильника клацніть лівою клавішею миші на відповідному віконці, вибір 

підтверджується появою значка ‗V‘. Для відміни вибору повторіть 

операцію. Програма запрошує підтвердження на видалення кожного 

світильника. 

 Зміна Коефіцієнта Обслуговування (MaintCoeff): дозволяє 

одночасно змінити коефіцієнт обслуговування помічених світильників. У 

вікні, що з'являється, вкажіть величину коефіцієнта і натисніть ОК для 

підтвердження даних. 

 Світильник (Luminaire): відкриває доступ до вікна вибору 

світильників (див. команду Add Luminaire). 
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OK: натисніть ОК для підтвердження введених даних і повернення в 

Робочу Область. 

 

Відкрити Файл Конфігурації Світильників (Open Luminaires Config.) 
 

Відкриває файл з раніше введеною і збереженою конфігурацією 

світильників. 

Ця функція дуже корисна у випадках використання конфігурацій 

світильників, що повторюються, в мережних структурах або системах. 

Зберегти Файл Конфігурації Світильників (Save Luminaires Config.) 

Команда зберігає поточну конфігурацію світильників в окремому 

файлі.  

Конфігурація світильників зберігається під тим же ім'ям, яке має 

Ваш проект, але з розширенням .TLM. 

 

Перевірка Накладення (Interference Check) 
 

За умовчанням програма не перевіряє наявність перетинів між 

елементами, що знаходяться в приміщенні. Це можна зробити, 

використовуючи команду Interference Check. 

При перетині об'єктів на екрані з'явиться повідомлення про помилку. 
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Контрольні питання до розділу 3 
 

1. Основні положення методики проектування освітлювальних 

споруд у світлотехнічних програмах. Що є вихідними даними для початку 

світлотехнічного проектування? 

2. Які якісні показники освітлення можна розрахувати за 

допомогою комп‘ютерних програм? 

3. Що таке фіктивні поверхні? 

4. Наведіть алгоритм проектування освітлювальних установок 

відкритого простору в програмі Саlculux. 

5. Яким методом виконується візуалізація у програмі Relux Vision? 

6. Що необхідно зробити в програмі Relux Professional, щоб 

привласнити однаковий матеріал і текстуру всім стінам або їх набору 

одночасно? 

7. Особливості програми Lightscape у роботі з тривимірними 

сценами. Чому визначення властивостей матеріалу є найважливішим етапом 

створення тривимірної сцени в програмі Lightscape? 

8. Поясніть метод розрахунку Radiosity на прикладі програми 

Lightscape. 

9. Алгоритм створення тривимірної освітлювальної установки у 

програмі DIALux. 

10. Етапи проектування освітлювальної установки в програмі 

EUROPIC. 

11. Який сервер запускається автоматично разом із запуском 

основного додатку в програмі EUROPIC? 

12. Якими двома способами можна створити геометрію приміщення 

в програмі EUROPIC? 

13. Проілюструвати процес візуалізації тривимірного зображення у 

програмі EUROPIC. 

14. Порівняйте можливі типи розрахунків у програмі EUROPIC. 

15. На яких методах світлотехнічного розрахунку базуються сучасні 

світлотехнічні програми? 

16. Перерахуйте світлотехнічні програми, що застосовуються для 

розрахунку освітлювальних спортивних споруд. 

17. Який метод візуалізації використовується у програмі DIALux? 

18. Наведіть недоліки програми Саlculux. 

19. Які фотометричні формати дозволяє виводити програма 

Саlculux? 
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ПРАКТИЧНІ ЗАВДАННЯ ДЛЯ САМОПЕРЕВІРКИ 

Завдання 1 

ПРОЕКТУВАННЯ ОСВІТЛЮВАЛЬНОЇ УСТАНОВКИ 

СПОРТИВНИХ СПОРУД  У ПРОГРАМІ EUROPIC 

 

Мета роботи: необхідно реалізувати світлові рішення для 

наступних спортивних споруд: футбол, міні-футбол, багатоцільовий 

спортзал, баскетбол, тенісний корт, суміжний тенісний корт у 

світлотехнічній програмі EUROPIC. 

 

Завдання розрахунку освітлення зводиться до визначення необхідної 

кількості світлових приладів для створення нормованого значення 

освітленості на спортивних об'єктах. При цьому розроблений проект 

освітлення повинен забезпечувати мінімальні витрати на спорудження та 

експлуатацію освітлювальної установки. 

 

При проектуванні доцільна послідовність дій, що наводиться 

нижче: 

1. Для введення нової „частини простору‖ треба ввійти у 

командному рядку до Free Prodgect/Create; натиснути ліву кнопку 

маніпулятора „миші‖ для введення певних прямолінійних елементів 

поверхні. При необхідності введення криволінійних елементів поверхні 

треба натиснути праву кнопку „миші‖, і задати кількість сегментів, за 

допомогою яких буде апроксимована дана крива. 

2. У вікні, яке з‘являється  автоматично, після замкнення контура 

поверхні (NEW ROOM), необхідно вибрати колір поверхонь (Color), 

висоту установки (Height), висоту робочої поверхні (Work Plane Height), а 

також вказати: будете ви працювати із зовнішньою сценою  (Exteriors), чи з 

внутрішнім приміщенням (Interiors). Наприклад, якщо це відкрите 

футбольне поле необхідно обрати зелений колір полу (Floor) і тип 

приміщення – Exteriors. 

3. У меню Furniture обрати Add Furniture, папку SPORT, в якій 

вибрати тип поля (Football, Tennis, Volleyball і ін.), і масштабувати його за 

своїми розмірами. Для введення додаткових меблів (ворота, сітка та ін) 

необхідно увійти до тієї ж вкладки Furniture/Add Furniture . 

4. Введення світлових приладів (СП): вибрати LUMINARIES/Add 

Luminaire. У вікні вибору світлових приладів обрати вкладку FloodLights 



 199 

(прожектори); із переліку світлових приладів вибрати той, що відповідає 

призначенню спортивної споруди (наприклад, EF 2000), і натиснути OK. У 

вікні LUMINARE DATA вказати координати установки СП (за 

необхідності положення СП можна змінити за допомогою „миші‖). Кожен 

СП може бути зорієнтований за допомогою „миші‖ або за допомогою 

„координат прицілювання‖ (aiming coordinates): Luminaire/Aim Luminairies. 

5. Введення щогли, на якій буде розміщений СП: Structures/Add 

Structure. У вікні Structure Data треба задати розміри щогл (x – Size,                 

y – Size), кількість колонок і рядів СП на щоглі, а також координати 

позиціювання. 

6. Наступним кроком необхідно, натиснувши праву кнопку „миші‖ 

на вільному місці, обрати з меню Luminaire List. У вікні, що автоматично 

відкрилося, вказати обраний раніше тип СП, і натиснути кнопку Insert, 

додавши необхідну кількість світильників. Прицілювання СП проводиться 

вручну за допомогою маніпулятора миші. Створена щогла може бути 

скопійована разом з усіма обраними СП. Далі необхідно зайти в Structures/ 

Duplicate Structure. У вікні DUPLICATE визначаємо кількість щогл, яка 

повинна з‘явитися після копіювання. 

7. Останній етап – розрахунок. Обрати з меню команду 

Calculation/Start/ 

8. Проаналізувати отримані результати. При необхідності повторити 

розрахунки. 
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СВІТЛОВІ РІШЕННЯ ДЛЯ СПОРТИВНИХ СПОРУД  

ВАРІАНТИ 1, 2, 3, 4 
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1 82 ОQ 2000 12 SPL2000/T/H 16 3 0,47 

0,35 
1=35  2=5  3=50  1=65  2=65  3=65  24,7 

2 105 ОQ 2000 16 SPL2000/T/H 20 4 0,68 

0,5 
1=50  

4=35  

2=30  3=25  1=55  

4=55  

2=65  3=60  33,0 

3 139 ОQ 2000 20 SPL2000/T/H 20 5 0,65 

0,42 
1=55  

4=30  

2=30  

5=60  

3=0  1=50  

4=35  

2=65  

5=60  

3=55  41,2 

4 240 ULTSW01 16 MQI2000/T9/40 24 4 0,52 

0,33 

1=50  
4=50  

2=30  3=25  1=45  
4=50  

2=60  3=60  33,7 

Симетричний широкий світлорозподіл 
 

Симетричний вузький світлорозподіл 
 

    Опора освітлювальна 

   Симетричне розташування відносно 

    осей (х-х)(y-y) 
 

 

 

 

 Розміри в метрах 
 

 Розміри в метрах 
 

Рішення 1   Рішення 2 

Рішення 3   Рішення 4 
Футбол (105 х 65) 

2
0
0
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     Футбол (105 х 65)                                                        ВАРІАНТИ 5, 6, 7, 8 
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5 99 ОQ 2000 16 SPL2000/T/H 20 4 0,78 

0,60 
1=25  

4=70  

2=55  3=60  1=60  2=70  3=60  33,0 

6 122 ОQ 2000 20 SPL2000/T/H 20 5 0,71 

0,55 
1=20  

4=65  

2=50  

5=80  

3=50  1=60  

4=70  

2=60  

5=70  

3=70  41,2 

7 149 ОQ 2000 24 SPL2000/T/H 24 6 0,72 

0,52 
1=35  

4=65  

2=25  

5=65  

3=50  

6=80  

1=50  

4=55  

2=60  

5=70  

3=65  

6=70  

49,4 

8 265 ULTSW01 20 MQI2000/T9/40 24 5 0,60 

0,42 
1=50  

4=65  

2=20  

5=80  

3=50  1=55  

4=70  

2=60  

5=70  

3=70  41,2 

 Розміри в метрах 
 

 Рішення 7      Рішення 8 
 

Симетричний широкий 

світлорозподіл 

  
Симетричний вузький  

світлорозподіл 

    
     Опора освітлювальна 

     Симетричне розташування 

     відносно осей (х-х)(y-y) 

 
 

 

 

Рішення 5       Рішення 6 

2
0
1
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    Міні-футбол                                            ВАРІАНТ 9, 10, 11, 12 
 

 
 

В
а
р

іа
н

т
 

С
ер

ед
н

я
 

го
р

и
зо

н
т
а
л

ь
н

а
 

о
св

іт
л

ен
іс

т
ь

, 
 

Л
к

  

С
в

іт
и

л
ь

н
и

к
 

К
іл

ь
к

іс
т
ь

 

 

 

Лампа 
В

и
со

т
а
 щ

о
г
л

и
 

Ч
и

сл
о

 

 с
в

іт
и

л
ь

н
и

к
ів

 

н
а
 1

 щ
о
г
л

і 

Р
ів

н
о
м

ір
н

іс
т
ь
 

Е
м

ін
/Е

с
р
 

Е
м

ін
/Е

м
а

к
с 

 

 

Кут повороту 

 

 

Кут нахилу 

С
п

о
ж

и
т
а
 

п
о
т
у
ж

н
іс

т
ь

, 

к
В

т
 

9 97 EF40 

400M SM 

8 ARC400/T/H 12 2 0,67 

0,53 
1=35  

 

2=25   1=45  2=40   3,4 

10 139 EF40 

400M SM 

12 ARC400/T/H 12 3 0,71 

0,57 
1=35  

 

2=15  3=40  1=50  

 

2=40  

 

3=45  5,1 

11 180 EF40 

400M SM 

16 ARC400/T/H 12 4 0,73 

0,60 
1=50  

4=45  

2=30  

 

3=15  

 

1=40  

4=45  

2=50  

 

3=45  

 

6,8 

12 251 OTQ 1000 8 SPL1000/T/H 12 2 0,70 

0,55 
1=35  

 

2=25  

 

 1=10  

 

2=5  

 

 8,4 

  Симетричний широкий  

   світлорозподіл 

  
       Опора освітлювальна 

    Симетричне  розташування 

       відносно осей (х-х)(y-y) 

 
 

 

 

Рішення 11     Рішення 12 

 Рішення 9      Рішення 10 
 

Розміри в метрах 2
0
2
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ВАРІАНТ 13, 14, 15, 16 
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13 Basketball 355 EF40  400M SM 8 ARC400/T/H 7 2х8 0,87 

0,78 
0  45  6,8 

14 Voleyball 358 EF40  400M SM 12 ARC400/T/H 7 2х8 0,91 

0,85 
0  45  6,8 

15 Basketball 340 CPC 400M+CPG 16 ARC400/T/H 7 4х6 0,86 

0,76 
0  45  10,3 

16 Voleyball 357 OTQ 1000 8 ARC400/T/H 7 4х6 0,96 

0,89 
0  45  10,3 

Розміри в метрах 

           Рішення   15 і  16 

           Рішення   13 і  14 

Багатоцільовий спортзал (40 х 20) 

Симетричний широкий світлорозподіл 

                                    
 
 

Симетричне розташування 

відносно осей (х-х) 
 

 

2
0
3
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ВАРІАНТ 17, 18, 19, 20 
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17 138 EF40 

250M SM 

8 ARC250/T/H 10 2 0,78 

0,70 
1=0  

 

2=40   1=40  2=45   2,2 

18 210 EF40 

400M SM 

8 ARC400/T/H 10 3 0,82 

0,73 
1=0  

 

2=40   1=40  2=45   3,4 

19 280 EF40 

400M SM 

12 ARC400/T/H 12 3 0,86 

0,77 
1=15  

 

2=10  

 

3=40  1=30  

 

2=35  

 

3=40  

 

5,1 

20 239 OTQ 1000 4 SPL1000/T/H 12 1 0,74 

0,58 
1=0  

 

  1=5  

 

  4,2 

    Симетричний широкий світлорозподіл 

                 
              Асиметричний світлорозподіл 

                 

         Опора освітлювальна 

                     Симетричне розташування 

                              відносно осей (х-х) (y-y) 

Розміри в метрах   Рішення   18   Рішення   17 

  Рішення   19   Рішення   20 

   Тенісний корт (24 х 11 / 36 х 18) 

2
0
4
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ВАРІАНТ 21, 22, 23 
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21 190 EF40 

250M SM 

12 ARC250/T/H 10 2 0,92 

0,78 
1=0  

4=30  

2=30  

5=30  

3=30  

6=0  

1=35  

4=40  

2=40  

5=40  

3=40  

6=35  

2,2 

22 286 EF40 

400M SM 

12 ARC400/T/H 10 2 0,91 

0,81 
1=0  

4=30  

2=30  

5=30  

3=30  

6=0  

1=35  

4=40  

2=40  

5=40  

3=40  

6=35  

3,4 

23 241 OTQ 1000 6 SPL1000/T/H 12 1 0,78 

0,65 
1=0  

 

2=0  

 

3=0  1=5  

 

2=5  

 

3=5  

 

5,1 

Симетричний широкий світлорозподіл 

  

Асиметричний світлорозподіл 
 

                                       Опора освітлювальна 

                      Симетричне розташування 

                        відносно осей (х-х) 

Розміри в метрах 

   Рішення   23 

   Тенісний корт (24 х 11 / 36 х 

18) 

   Рішення  21 і 22 

2
0
5
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ВАРІАНТ 24, 25 
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24 163 EF40 

400M SM 

12 ARC400/T/H 12 3 0,70 

0,59 
1=0  

4=35  

2=15  

5=15  

3=35  

6=0  

1=45  

4=45  

2=45  

5=45  

3=45  

6=45  

5,1 

25 269 OTQ 1000 6 SPL1000/T/H 12 2 0,79 

0,68 
1=0  

4=0  

2=15  

 

3=15  

 

1=10  

4=10  

2=10  

 

3=10  

 

8,4 

 Суміжні тенісні корти (24 х 11 / 36 х 36) 
Симетричний широкий світлорозподіл 

  
 

Асиметричний світлорозподіл 

  
      Опора освітлювальна 

Симетричне розташування відносно осей 

(х-х)(у-у) 

Розміри в метрах Рішення   24 

Рішення   25 

2
0
6
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ВАРІАНТ 26, 27 
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26 148 EF40 

400M SM 

12 ARC400/T/H 12 2 0,71 

0,61 
1=0  

4=20  

2=20  

5=20  

3=20  

6=0  

1=45  

4=45  

2=45  

5=45  

3=45  

6=45  

5,1 

27 189 OTQ 1000 6 SPL1000/T/H 12 1 0,75 

0,63 
1=0  

 

2=30  

 

3=0  

 

1=5  

 

2=5  

 

3=5  

 

6,3 

 

Суміжні тенісні корти (24 х 11 / 36 х 36) Симетричний широкий світлорозподіл 

  

 

Асиметричний світлорозподіл 
 

       Опора освітлювальна 

      Симетричне розташування 

          відносно осей (х-х) 

Розміри в метрах 

Рішення 27 

Рішення   26 

2
0
7
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Завдання 2 

Дизайн систем зовнішнього освітлення футбольного 

стадіону в програмі DIALux 

 

Мета роботи: навчитися створювати комп'ютерну модель 

ілюмінації спортивного об‘єкта, засвоїти основні етапи процесу 

візуалізації. 
 

Особливості роботи із зовнішнім освітленням у програмі 

DIALux 

 

1. У стартовому діалозі необхідно вибрати Новий проект для 

зовнішньої сцени (рисунок 1). 
 

 
 

Рис. 1 
 

2. Необхідно ввести елемент підлоги (елемент місцевості), що 

може використовуватися тільки в зовнішній сцені. Редагування елемента 

місцевості проводиться аналогічно внутрішнім приміщенням. Вони 

можуть мати будь-яку багатокутну форму (рисунок 2).  
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Рис. 2 

 

Елементи підлоги мають власні фотометричні властивості. 

Результати розрахунку обмежені їх поверхнею. За початкових умов 

елемент місцевості має прямокутну форму і висоту 0,0м. 

Для того щоб змінити форму елемента підлоги, необхідно 

переключитися в режим редагування за допомогою правої кнопки 

маніпулятора «миші» (рисунок 3). 
 

 
 

Рис. 3 
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3. Розміщення фурнітури в приміщенні, вибір та розміщення 

світильників. 

У менеджері проекту структура зовнішньої сцени відповідає 

внутрішнім приміщенням. Меблі й світлові прилади розташовують за 

допомогою тих самих засобів , що й у приміщеннях внутрішнього проекту. 

4. Вставка і редагування розрахункової поверхні. Треба перейти до 

папки розрахункових поверхонь і перемістити відповідний об'єкт 

(розрахункову поверхню), використовуючи при цьому спосіб «перемістити 

і відпустити» у вікно CAD.  

5. Розрахувати освітлення прожектором об‘єкта чи споруди. Для 

цього треба натиснути кнопку Calculate (розрахувати). 

6. Для відображення освітленого вигляду натисніть кнопку Render  

 

 

ВАРІАНТИ ЗАВДАНЬ 

 

 

ВАРІАНТ 1 
 

Стадіон 

"Олімпійський", 

місто 

Київ 

 

 

ВАРІАНТ 2 
 

Стадіон 

"Металург", 

місто 

Дніпропетровськ 
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ВАРІАНТ 3 

 

Стадіон 

"Шахтар",                          

місто 

Донецьк 

 

 

 

ВАРІАНТ 4 
 

Стадіон 

"Чорноморець",                         

місто 

Одеса 

 

 

ВАРІАНТ 5 
 

Стадіон 

"Україна",                         

місто 

Львів 

 

 

 

ВАРІАНТ 6 
 

Стадіон 

"Металіст",                              

місто 

Харків 
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ПРИКЛАДИ ВИКОНАННЯ РОБОТИ 

 

 

а) Тривимірна модель освітлення стадіону в тонких лініях 

 

 

 

 

 

б) Візуалізація освітлення спортивного об‘єкту  
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в) Приклад створення освітлювальної установки відкритих 

спортивних споруд 

 

 
 

г) Модель освітлювальної установки закритої спортивної споруди 
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